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Close tank cover.................. 564 Close Ink Tank Cover ...........ccceeevvunnennn.. Locking Caster Lock to immobilize the caster. Select the folder to specify a hot folder, and click the OK button. Press the Navigate button. Press A or V¥ to select the type of paper, and then press the OK button. Note Click Apply Favorite to replace the favorite settings with the
current print settings. 582 About This User Manual .......cc....ccceeuunnneee 582 Manuals for this printer Manuals for this printer This printer has the following manuals. Select the Overlapping Order menu from the Object menu. Page 296 Matching iPF770 ¢« Matching Mode You can select a matching mode to suit the print job. ¢ Resizing Originals to Match
the Paper Size P.58 - « Resizing Originals to Fit the Roll Width P.60 - ¢ Resizing Originals by Entering a Scaling Value P.63 -... Roll Loading Slots Slide the Roll Holder along these slots. Loading and Printing on Sheets iPF770 Select the type of paper. Holding the Roll Holder flange (a), rest the Roll Holder shaft on the Roll Ledge (b). Page 134
Making the Original Orientation Match the Paper Orientation (Mac OS) iPF770 Access the Main pane. Print Selected Area(Excel) iPF770 If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper). Page 422 Menu Settings iPF770 Setting Item Description, Instructions Line & Smoothing ¢ If you choose Smooth
Settings Manag- ThickenFineLines Select On to print fine lines more distinctly. The printer driver is used to con- figure basic settings to match the type of media loaded in the printer. | 10 min. Determine the straightest set of lines. 271 Output Settings Panel ..........c.c..ccceeeeenniis Description Color (CAD) 1 Print in standard colors. Page 71 iPF770 Printing
at Full Size (Mac OS) Access the Main pane. Page 424 Menu Settings iPF770 Setting Item Description, Instructions System Keep Paper Size Setup Choose Off to give priority to margin settings. Click the Disabled Items button in the About dialog box. 554 Messages regarding paper .............. (See "When to Replace Ink Tanks.") P.501 - If a message
requests you to replace an Ink Tank, press the OK button. tab ( * If the Tab Selection screen is not displayed, press the Menu button. From the Applications menu, select Canon Utilities > imagePROGRAF Media Configuration Tool > CNWIMCT. Press A or ¥ to select Adjust Printer, and then press the OK button. *1:Canon cannot guarantee the
accuracy of these estimates. Specifying the Paper Length iPF770 Press A or V¥ to select the type of paper loaded in the printer, and then press the OK button. Printing Options Using Rolls and Sheets iPF770 Printing procedure Printing procedure Printing Options Using Rolls and Sheets ...................... 14 Turning the Printer On and Off ..........................
Moving an Object iPF770 Place the pointer at a corner of the selection box around the object to show the arrow handle, and drag this handle to change the object size. for the last character. These estimates will Important also vary depending on the conditions of printer use. zles are clogged. *1: The printer automatically enters Sleep mode when idle
for a specific period (by default, five minutes), that is, if no print jobs are received or buttons are pressed while all covers are closed. Ethernet Port Connect an Ethernet cable to this port. iPF770 Cutting the Leading Edge of Roll Paper Automatically Press A or ¥ to select Yes, and then press the OK button. Note Driver Matching Mode Driver Matching
Mode... Folding back the paper at the fold lines of the center substitutes for duplex print- ing. * Always specify the same type and size of paper in the printer menu and printer driver. Page 246 Configuring Special Settings iPF770 Item Details Center sheets and print areas When this setting is off, printing is performed without changing the position.
Page Options Dialog Box iPF770 Setting Details Crop Marks You can print with the crop marks. Maintenance Replace the cartridge full. We recommend cleaning the Ejection Guide even if it does not appear dirty, because it may actually be covered with paper dust. ¢ Printing Photos and Images P.29 - ¢ Printing Office Documents P.33 - ¢ Print
Quality Choose the level of print quality. Checking Ink Tank Levels Checking Ink Tank Levels On the Display Screen, you can check how much ink is left in the ink tanks. 251 Accessing the Printer Driver Dialog Box from Applications ................ * Resizing Originals to Fit the Roll Width P.60 - « Resizing Originals by Entering a Scaling Value P.63 -
Fit Roll Paper Width Resizes the document image to match the roll width. From the application software's File menu, select the printer setup menu to open the Print dialog box. *You can change the numbers by clicking either A button or ¥ button. ¢ Align Bottom Lays out the objects, justifying them to the bot- tom. Note ¢ Apply Sharpness Place a
checkmark here to set the sharpness. Page 460 iPF770 User's Guide... Page 319 Updating paper information Click the Support Information button. | 5 min. 446 Configuring the IP Address Using imagePROGRAF Device Setup Utility ............ Resizing Originals to Fit the Roll Width iPF770 Confirm the print settings and print as desired. Setting Details
Use mm as the ruler unit. Page 89 iPF770 Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) Click the Page Setup tab to display the Page Setup sheet. iPF770 Maintenance Cartridge Maintenance Cartridge Maintenance Cartridge Maintenance Cartridge .........c...ccocevvenn.en iPF770 User's Guide Basic Printing Workflow Enhanced
Printing Options Windows Software Mac OS Software Handling and Use of Paper Control Panel Operations and Display Screen ............ 398 Printer Menu .................. 406 Printer Parts Network Setting Print Job Management Adjustments for Better Print Quality Maintenance and Consumables Troubleshooting Error Message... * Import Click to display
the Open dialog box, which enables you to import favorite settings saved as a file. Any jobs sent from the computer are held without being printed. This completes the proce- dure for switching to Extended position A. iPF770 Free Layout Main Window Click the Print button in the Print dialog box. iPF770 The Features of Preview Preview Preview The
Features of Preview ..........cccccevvnneennn. 169 Starting Preview .........ccccccveeevvnnnnnnn. Paper Detailed Settings Dialog Box iPF770 Paper Detailed Settings Dialog Box Paper Detailed Settings Dialog Box The Paper Detailed Settings dialog box offers the following settings. This topic describes how print photographic images in monochrome. Click Manual in the
Paper Source list. Button Details Upper Button Turn at the position of Right Button Turn at the position of Left Button... Finished Size Settings Dialog Box Finished Size Settings Dialog Box This dialog box is displayed when you select Finished Size Settings from the Edit menu. 521 Updating the Firmware ..............ccceeeevnnne. Pasting a Copied or Cut
Object Pasting a Copied or Cut Object Click Copy or Cut from the toolbar. If multiple errors have occurred, the tabs for errors that have occurred other than the currently displayed error are displayed flashing. Page 354 Updating Media Information After Installation iPF770 ¢ If the main window is displayed at this time, it means that the media
information has already been updated and the rest of the operation is not needed. 113 Printing Originals Centered on Rolls (Windows) .................. 113 Printing Originals Centered on Rolls (Mac OS) ................... * Color Mode You can select a color mode to suit the print job. Insert it firmly until the roll touches the flange (a) of the Roll Holder, leav- ing
no gap. * If Show Job Log is set to off and an administrator password is configured in the printer, the administrator password needs to be entered on startup. Loading and Printing on Rolls iPF770 ¢« The Power Lamp and Message Lamp are not lit (even once), and nothing appears on the Display Screen Make sure the printer is plugged in correctly. To
apply ColorSync to previews, check the Soft Proof check box. printer during (See "Clearing Jammed Roll Paper.") P.527... Rotate Left Rotates the object 90 degrees counterclockwise. Click Line Drawing/Text in the Print Priority list. Click the Add button to return to the Paper sheet. Press A or ¥ to select Paper Details, and then press the OK button.
Photos and posters can be printed without worrying about margins. Page 452 Configuring the Printer's TCP/IP Network Settings With RemoteUI iPF770 Item Details Default Setting Secondary DNS Server Address Specify the IP address of the secondary DNS server. 502 Cleaning the Printhead ........cc....cccceuuiiie e For more information on the



procedure for opening the Media Configuration Tool main window, see "Media Configuration Tool Main Window." P.357 = Note The Edit Media Types dialog box is displayed. iPF770 Laying out a Multiple-File Document on One Page * Object Size You can confirm the object size. Press the Release Lever back and remove the roll. The appropriate
media type differs between the case of genuine Canon paper or Canon feed confirmed pa- per and the case of paper other than Canon feed confirmed paper. * For details on settings items, see "Adjusting the Color in the Printer Driver." P.46 - Note Object Adjustment Dialog box: Color Object Adjustment Dialog box: Color In the Object Adjustment
dialog box, you can specify what type of print jobs to apply color adjustment to. ¢ If you click on the Add to Startup folder check box in the Color imageRUNNER Enlargement Copy dialog box, the icon of Color imageRUNNER Enlargement Copy utility will appear on the task bar when starting Windows Note thereafter. You can set the preferences for
Preview. iPF770 The Features of Color imageRUNNER Enlargement Copy Color imageRUNNER Enlargement Copy Color imageRUNNER Enlargement Copy The Features of Color imageRUNNER Enlargement Copy ................ 201 Starting Color imageRUNNER Enlargement Copy .................. 201 Color imageRUNNER Enlargement Copy Dialog Box
.................. 202 Hot Folder ...............c............... * If the Enlarged/Reduced Printing check box is not displayed on the Page Setup sheet, clear the... Make sure the Ink Lamp is lit in red. The following message may be displayed in Windows 8 ¢ or a later OS. 546 HP-GL/2 problems With HP-GL/2, printing is misaligned ........................548 Lines or images
are missing in printed HP-GL/2 jobs......c.............. * Send Backward Moves the object one position to the back. * Conserving Roll Paper by Printing Originals Without Top and Bottom Margins P.124 -... Page 212 Steps to install iPF770 Click the Start button. This may damage the Printhead. Attempting to move the stand when the casters are not locked
poses a risk of injury or damage to the location site. Page 85 iPF770 Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS) Access the Page Setup pane. This retainer holds paper as it is fed. Page 214 When Print Plug-In for Office is not displayed iPF770 Install Print Plug-In for Office. Select layout. (xxxx is 0501, 0903, or 0904)
............... iPF770 Preferences Dialog Box Preferences Dialog Box Preferences Dialog Box This dialog box appears when you select Preferences from the File menu. 135 Cutting Roll Paper After Printing (Mac OS) ......................136 Windows Software Printer Driver Printer Driver Settings ............................140 Specifying Paper in the Printer Driver
........................ 142 Confirming Print Settings ............................ Steps to uninstall * When you install this software, the virtual printer Canon imagePROGRAF PrintPlugln may be installed. The * on the right side of an item indicates the default value. Page 253 iPF770 Main Pane Common Items ¢ Media Type Select the paper type. * Support Information
Click to access the Canon support webpage, where you can find the latest information on the printer and con- sumables, check for printer driver updates, and browse other information. iPF770 Borderless printng not possible. iPF770 The roll is empty. Select image size. Page 555 iPF770 Sheet printing is selected.......................... 560 The following ink
tanks cannot be recognized.................... 565 The paper is too small.............ccceeenneennne. Select the IPv6 tab. Choose cool black (tinged with blue), pure black (neutral), warm Gray Tone black (tinged with red), and so on. * Add Button Click the button to open the Easy Setup Wizard dialog box so that you can add a hot folder. In this case, click ISO A3. Easy
Settings iPF770 « Restore Defaults Button Click the button to reset to the setting when starting Free Layout. iPF770 When to Replace Ink Tanks These symbols may be displayed above the ink level: ! if ink is low, X if no ink is left, and ? * Important When using Banner Printing, some of the settings are disabled, including Borderless Printing, Enlarge/
Reduce Printing, and Layout. Click Print to print, and click Cancel to cancel the print. Format Dialog Box iPF770 Format Dialog Box Format Dialog Box This dialog box appears when you select Format from the Object menu after you select an object. Ink insufficient. 556 MediaType Mismatch ...........ccccceeeunneenne. 556 The paper is too
small........c..oovevivinn. If the paper drops, printed documents may be damaged. inch Use inches as the ruler unit. Page 190 Laying out a Document Created with Multiple Application Programs on One Page iPF770 In the Layout sheet, click on the Page Layout check box and select Free Layout from the list. ¢ Giving Priority to Particular Graphic
Elements and Colors for Printing P.52 -... 210 Status Monitor ................ 462 - Accounting ................... Setup DNS Domain Name Specify the DNS domain name. iPF770 Updating Media Information After Installation The Installation Complete screen appears. iPF770 Adjusting the Vacuum Strength ¢ A test pattern is printed in black when you choose
A:High or in magenta if you choose B:Standard/Draft. For more information about the recycling of this product, please contact your local city office, waste authority, ap- www.canon-europe.com/weee proved scheme or your household waste disposal service or visit , or ... In this case, click ISO Select the Enlarged/Reduced Printing check box. The
following procedure is for Windows 7. * When several objects are selected, you cannot select Rotate. Enter 430 (16.9 in) in both Width and Height. When "Stop printing?" is displayed, press A... Page 552 Ink Level Detection iPF770 After checking the message, press the p button. * Units Set the unit for paper length, margins, and so on. menu is set to
Pause, the type of paper loaded However, note that this error may cause paper jams and affect the printing quality. Page 120 Printing Originals Centered on Sheets (Mac OS) iPF770 Make your selection in the Print Target list. Messages regarding the maintenance cartridge Messages regarding the maintenance cartridge Insert the maintenance
cartridge......ccceceveeennnnnns 569 Wrong maintenance cartridge............cccccceuun.e. Here, measure- ments are entered in millimeters. In this case, ISO A2/A3 (420.0mm) is selected. Network Environment iPF770 Network Environment Network Environment Network Environment Network Environment System requirements The system requirements, which
vary depending on your network, are as follows. Main Sheet iPF770 Click Preferences to display the Printing Preferen- ces dialog box, titled with the name of this printer. ¢ For tips on confirming print settings, see "Confirming Print Settings ." P.143 - Note Printing by using Custom Size This section describes how to print using Custom Size based on
the following example. Print Plug-In for Officefeatures iPF770 Print Plug-In for Office Print Plug-In for Office Print Plug-In for Officefeatures ..........c............. 210 Steps toinstall .........ccceevvviiiiinninnns, 210 Steps to uninstall ...........c.ceeevnennnee. 213 When Print Plug-In for Office is not displayed .................... 213 To start from Microsoft Word .............ccccceuneennes
Color Adjustment Sheet: Color iPF770 ¢ Details Here, you can confirm detailed settings values for each listed item for the selected Print Target. Note User's Guide... Shape Colors Model number Ink Type... iPF770 Cannot connect the printer to the network Cannot print over a network Cannot print over a network Cannot connect the printer to the
network ..., To update the paper source and media type settings in the printer driver, select the desired Paper Source option and click Paper Detailed Settings Dialog Box Paper Detailed Settings Dialog Box... Change Password The password that can be entered is a number from 0 to Menu 9999999. Page 458 Configuring the IP Address
Using imagePROGRAF Device Setup Utility iPF770 When specifying an IPv4 IP address Start imagePROGRAF Device Setup Utility from the start menu. 400 How to View Instructions with Navigate ...................... 404 Checking Instructions During Printer Operations ..................... *3: Available if Adj. Printing on Oversize Paper iPF770 Printing at full
size Printing at full size Printing on Oversize Paper ...........cccceeevunneen. 68 Printing at Full Size (Windows) ......cccccevvuveennnnes 69 Printing at Full Size (Mac OS) .....cccovvvvvnevnnnnns 70 Borderless Printing at Actual Size ..........c.c..cc...... 72 Borderless Printing at Actual Size (Windows) .................... Multicast DNS Serv- Specify the printer's Multicast DNS service name.
» There is no margin (that is, a margin of 0 mm) during borderless printing on rolls. Click the Show/Hide button. Select Disabled Items in the Manage combo box and click the Go button. Printing takes longer and consumes more ink than in other modes, but this mode offers superior printing quality. iPF770 Go to Page Dialog Box ¢ You can input
between 10 and 400. Page 594 User's Guide © CANON INC. Dodatne informacije o recikliranju ovog proizvoda zatrazite od svog lokalnog gradskog ureda, sluzbe za zbrinja- vanje otpada, odobrenog programa ili komunalne sluzbe za uklanjanje otpada ili pak na stranicama www.canon-europe.com/weee www.canon-europe.com/battery -... Select Next.
Matching iPF770 « You can also click the up or down arrow, or enter the number directly to increase or decrease the value. Maintenance Cartridge Absorbs ink used for maintenance purposes such as head cleaning. Printing Vertical or Horizontal Banners (Large-Format Printing;... Running several applications while printing may interrupt the
transfer of print data and affect printing quality. Page 194 Aligning Objects iPF770 * Center Vertically Lays out the objects, justifying them to the verti- cal center. if you have deactivated ink level detection. * This function cannot be used on 64-bit version of Windows. Page 355 If the following message is displayed, configure the settings by using the
following procedure. You can print large exhibits and posters, or print the Landscape or Portrait Orien- tation Page Sizes made in the Large-Format Printing Wizard. For details on Print Matching Roll Width, see "Print Matching Roll Width(PowerPoint)."... On the Layout sheet, click Special Settings to display the Special Settings dialog box. iPF770
Resizing Originals by Entering a Scaling Value (Mac OS) Select the width of the loaded roll in the Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm). Cause Corrective Action The Printhead noz- Follow these steps to clean the Printhead. Page 79 P.146 » Make sure the Main sheet is displayed. Important Choose Print in the application
menu. iPF770 Print Using Registered Settings(PowerPoint) Print Using Registered Settings(PowerPoint) Print Using Registered Settings(PowerPoint) Prints using the registered settings. cart. Page 348 Using the Output Stacker iPF770 When using 24-inch or Al (portrait) roll paper, pull out the Adjustable Stopper (a). Click OK to close the Custom
Size Settings dialog box. ¢ To import a favorite, click Import and specify the favorite file. The surface of the paper is dirty iPF770 Cause Corrective Action You are printing on heavyweight paper For paper-based media such as Heavyweight Coated Paper, set the VacuumStrngth to or paper that curls or wrinkles easily af- Strong or Strongest in the
Control Panel menu. * The layout may collapse if you create a form using existing data. Stop printing by pressing A or ¥ to select Stop Printing. ¢ Select the printer model that matches the media information file you are attempting to import. Borderless Printing by Resizing Originals to Fit the Roll Width iPF770 Select the Borderless Printing check
box to dis- play the Information dialog box. 201 Print Plug-In for Office ............... 325 Printing From a Desired Starting Point ...................... 342 Removing Sheets ........cccceevveeeennnnnee. 344 Clearing a Jammed Sheet ...........ccuunennnne. 530 -... "Remove paper and check pap. 87 Printing Vertical or Horizontal Banners (Large-Format Printing;... If the message is
displayed again, contact your Canon dealer for assistance. Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS) iPF770 Click the Layout tab to display the Layout sheet. Important ¢ If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. Page 137 iPF770 Cutting Roll Paper After Printing
(Mac OS) Choose Page Setup from the application menu to display the Page Attributes dialog box. 291 Color Settings Panel ............c.ccceeeeenn.e. The names of the media information files contained in the selected folder are displayed in the Media Infor- mation File field in the Add Media Type dialog box. Preview Main Window iPF770 On the Print dialog
box in the apllication software, click the Print button. Feeding Roll Paper Manually iPF770 ¢ 3-Inch Paper Core Attachment L (Holder Stopper side) ¢ 2-Inch Paper Core Attachment « Store the roll in the original bag or box, away from high temperature, humidity, and direct sunlight. Roll (609.6mm) 594.0 mm (23.39 in) ISO A1/A2 Roll (594.0mm)
515.0 mm (20.28 in) JIS B2/B3 Roll (515.0mm) 431.8 mm (17.00 in) 17-in. This area appears when you click Drawer from the tool bar. 86 Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) ............ The next screen presents selections for the country or area where the printer is used. Enter Copies. Laying out a Document
Created with Multiple Application Programs on One Laying out a Document Created with Multiple Application Programs on One Page Page... iPF770 Print Entire Sheet(Excel) Printing Wizard dialog box ¢ If you want to change the display to another file or application while the Printing Wizard is open, close the Printing Wizard dialog box. Note From
the Windows start menu, select All Programs > Canon Printer Uninstaller > imagePROGRAF Printer Driver Uninstaller to display the Delete Printer window. Page 323 iPF770 Loading Rolls in the Printer Positioning your hands as shown, open the Roll Cover. Page 494 iPF770 User's Guide... iPF770 Messages regarding ink Messages regarding ink Ink
insufficient...........c...ccooeel 564 No inkleft.......ccooevvveiiiniiinnnn.is Confirm the print settings, and then click Print to start printing. This may damage the printer and Roll Holder. 514 Cleaning Inside the Top Cover ...........cccccceuunneen. 514 Other Maintenance Preparing to Transfer the Printer .......................... Preparing to Transfer the Printer iPF770 Other
Maintenance Other Maintenance Preparing to Transfer the Printer ........................ 518 Reinstalling the Printer .............ccoeevevnnneen. Input the scaling value in numerical characters. Removing Sheets iPF770 Pull the Release Lever forward and close the Top Cover. Select the printer in the dialog box, and then display the printer driver dialog box. Enter the
Width and Length of the paper, as well as the Price for the area of the configured width x height. (254.0mm) is selected. Page 88 Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) iPF770 Close the printer driver dialog box. Page 490 Manual Banding Adjustment iPF770 Paper to Prepare When Using Rolls An unused roll at
least 10 inches wide When Using Sheets Two sheets of unused paper of at least A4/Letter size Perform adjustment as follows. Note * A maximum of 10,000 records are saved in a print job log. * If the installer screen does not appear automatically, open the CD-ROM drive icon of your computer and double-click the iPFInst.exe icon. Note Cleaning the
Printhead Cleaning the Printhead If printing is faint, cleaning the Printhead may improve results. 410 Menu Settings .........cccceevvuvernnnnnnn. 416 Status Print ........ccooevvvvieinnnnn. 425 Printing Interface Setting Reports ........ccccceeveneeeen. 428 Printer Menu Operations Printer Menu Operations The printer menu is classified into regular menu items available when
no print job is in progress and menu during printing items only available while printing is in progress. 567 Printhead error ...........c...cccccveeennene. Page 364 Changing Media Names iPF770 Click the Add Genuine Paper button in the Media Configuration Tool main window. If you are using regular data acquisition, this area allows you to view the collective
job logs for each specified period. Edit and rearrange the image in the Canon imagePROGRAF Free Layout window as desired. iPF770 Resizing Originals to Fit the Roll Width (Mac OS) In the Media Type list, select the type of paper that is loaded. Note For example, choose 11 if you cannot decide whether pattern 10 or 12 is better. * When you select
Free Layout, all other setting items will be disabled. 22 Canceling Print Jobs from Mac OS ........................ 23 Canceling Print Jobs from the Control Panel Canceling Print Jobs from the Control Panel To cancel printing or reception of print jobs, press the Stop button on the Control Panel. The latest media information file is downloaded from the
Internet. Page 32 Access the Main pane. Page 377 If the following message is displayed, configure the settings by using the following procedure. 42 Specifying Colors and Printing CAD Drawings .................... * Note The characters that can be entered for Name in Printer Driver and Name on Control Panel are stated below. « The Accounting Manager
in Status Monitor displays approximate estimates of the amount of paper consumed and the ink consumed per job. Press A... Priority setting for rotating 90 degrees Priority setting for rotating 90 degrees You can select Rotate 90 Degrees If Possible or Use Driver Settings from the Options menu. AdjustFaintLines If fine lines are printed in colors that
do not match the col- ors of other shapes, selecting Off may help produce the expected results. ¢ Printing Photos and Images P.29 = ¢ Printing Line Drawings and Text P.38 = ¢ Printing Office Documents P.33 -... Using Favorites iPF770 Make sure the Main sheet is displayed. Specifying Paper in the Printer Driver iPF770 Specifying Paper in the
Printer Driver Specifying Paper in the Printer Driver If you have replaced the paper, you must complete the following settings in the printer driver. 373 - Handling and Use of Paper Control Panel Printer Parts Network Setting... iPF770 Hot Folder ¢ Hot Folder The hot folder list appears. You can specify a range between 5 and 600%. iPF770
Confirming Print Settings ¢ A variety of settings are available in the printer driver to suit different printing applications. 575 Specifications Specifications ¢ The following values may vary depending on the operating environment. Refer to the Setup Guide for details on packing the printer and installing it after transfer. Keeping the right edge of the
paper aligned with the exten- ded line of the Paper Alignment Line (a) to the right of the ejection guide and the leading edge aligned with the groove (b) at the far end of the Platen, load the paper at... Page 417 iPF770 Menu Settings Setting Item Description, Instructions Paper Details (The type of pa- CutDustReduct. Page 76 Borderless Printing at
Actual Size (Mac OS) iPF770 Access the Main pane. Page 497 iPF770 Replacing Ink Tanks According to the message, replace the ink tank or prepare a new ink tank. * Align Left Lays out the objects, justifying them to the left. Note * Example of a Mac OS network In Mac OS networks, print over TCP/IP using the Bonjour function. Lahko pa tudi
obiSCete na- www.canon-europe.com/weee www.canon-europe.com/battery So spletno stran , ali -»... iPF770 Accounting Manager Main Window Select Accounting in the Accounting menu. After the roll is rewound, it stops automatically. iPF770 Pausing Printing Pausing Printing Pausing Printing Pausing Printing Pausing Printing During printing, if you
set Pause Print in the Control Panel menu to On, printing is stopped at that point and the printer enters a state in which printing is paused. Using the Output Stacker iPF770 Output Stacker Output Stacker Using the Output Stacker Using the Output Stacker This section describes how to use the Output Stacker. Page 592 iPF770 User's Guide... Click
Print Selected Area. Choose Print in the application menu. To ensure a comfortable working environment, clean the printer exterior about once a month. Important If you are using the Media Configuration Tool, the Media Information File is downloaded automatically. Items you select are highlighted. Displaying Job Properties or Period Properties
iPF770 « Listed Jobs Exports the data for the print jobs currently displayed in the list as a CSV file. (See "Accessing the Print- er Driver Dialog Box from Applications .") P.146 - Make sure the Main sheet is displayed. iPF770 Changing the Object Overlapping Order ¢ Align Right Lays out the objects, justifying them to the right. Use RemoteUI Settings
used by RemoteUl. IEEE 802.3u 100Base-TX/Auto-Negotiation, IEEE 802.3ab 1000Base-T/Auto-Negotiation, IEEE 802.3x Full Duplex IEEE 802.3az EEE Protocols SNMP (supports Canon-MIB), HTTP, TCP/IP (IPv4/IPv6) For information on the ink the printer supports, see "Ink Tanks." P.496 - Paper For information on the types of paper the printer
supports, refer to the Paper Reference Guide. The name you entered is displayed in Registered Settings. Object Adjustment Dialog box: Monochrome iPF770 * Brightness Adjust the overall image brightness as desired. Note Items to Prepare When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide When Using Sheets Two sheets of unused
paper, A4/Letter size (or one sheet when using A2) Perform adjustment as follows. ColorSync iPF770 ColorSync ColorSync Check that ColorSync is selected in Matching Mode. If the message is displayed again, write down the error code and message, turn off the printer, and contact your Canon dealer for assistance. Click Manage Custom Sizes in the
Paper Size list to display the Custom Paper Sizes dialog box. Important Do not attempt to print or turn the printer off while the program is communicating with the printer. Select the IPv4 tab. Cannot adjust printhead. Image edges are blurred or white banding occurs iPF770 Cause Corrective Action When borderless printing is used, the Specify No in
Auto Cut in the printer driver before printing. Easy Settings iPF770 ¢ Restore Defaults Button Click the button to reset to the setting when starting Preview.  Although you can even set Custom Size for the paper size, the maximum settable size is 3.2 m. (See "Attaching the Roll Holder to Rolls.") P.320 -... When this button is clicked, the Edit Media
Types dialog box is displayed, which allows you to add media information files released by Canon to the printer control panel and printer driver. iPF770 Using Favorites Using Favorites Using Favorites You can register print settings as Favorites to reuse settings from a particular job that met your expectations, or settings for a particular page size
that you will use repeatedly. Important From the Applications menu, select Canon Utilities > imagePROGRAF Media Configuration Tool > CNWIMCT. Page 547 iPF770 Removing Installed Printer Drivers Follow the instructions on the screen to remove imagePROGRAF Device Setup Utility. Page 211 iPF770 Steps to install Insert "User Software CD-
ROM" into the CD-ROM drive and start the installer. In this case, select Print from the menu in the appli- cation software, and configure the settings in the up- per part of the printer driver screen that is displayed. Free Layout Main Window Free Layout Main Window The Free Layout main window consists of the menu and tool bars, layout area and
dialog areas. For color matching based on ICC profiles, select ICC Matching Mode or Host ICM Mode, depending on your color matching system. Page 492 Adjusting Line Length iPF770 Additionally, two modes are available in both AdjustmentPrint and Change Settings : A:High or B:Standard/ Draft. To start printing from the current position, close
the Top Cover. Setting the Print Parameters iPF770 As necessary, set the print conditions in the hot fold- er. Paper cutting (to have the roll cut at your specified position) Press the Feed button. To print the entire sheet, cancel the setting of the print area. Click OK to close the Information dialog box. 261 Color Settings Pane: Monochrome

........................ 262 Object Adjustment dialog box: Monochrome ....................263 Page Setup Pane ..............................263 Preview The Features of Preview ............................265 Starting Preview .............................. Page Setup Dialog Box iPF770 ¢ Divisions You can change the number of divisions of grid lines so that they serve as a guide to laying out
objects. iPF770 Adjusting the Feed Amount Adjusting the feed amount Adjusting the feed amount Adjusting the Feed Amount .......................... 487 Selecting a Feed Amount Adjustment Method ................... If Roll Paper is selected in Paper Source, select the width of the roll paper that is loaded in Roll Width. Important ¢ Do not lift the paper when
holding printed documents before cutting. 496 Replacing Ink Tanks ..............cccceeevnnnees 496 Checking Ink Tank Levels .........ccccccevvneennen. 500 When to Replace Ink Tanks ...........cc.cevuneennnn. 501 Ink Tanks Ink Tanks When purchasing, check the Model number. iPF770 Making the Original Orientation Match the Paper Orientation (Mac OS) Select the width of

the loaded roll in the Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm). * For tips on confirming print settings, see "Confirming Print Settings ." P.250 - Note Printing on Non-Standard Paper Sizes Printing on Non-Standard Paper Sizes For printing on non-standard size paper, first register the paper size in the printer driver. (1-63
characters) Canon iPFxxxx ice Name This name will be displayed when Bonjour functions are used. * The Device Settings sheet is also an extension of the printer driver. The Software License Agreement is displayed. For information on the types of paper the printer supports, refer to the Paper Reference Guide. Click Print Entire Sheet. In the Page
Size list, click the size of the original as specified in the source application. Page Size, click the size of the original as specified in the application. Checking the update Checking the update After updating the media information using the Media Configuration Tool, you can check whether the update has been applied to the printer in the control panel of
the printer. iPF770 The Features of Preview Preview Preview The Features of Preview .............ccc..ccou... 265 Starting Preview ..........ccceevvvvevennnnns Page size: 10x12 inches (254.0x304.8 mm) ¢ ¢ Paper: Roll paper ¢ Paper type: Canon Premium Glossy Paper 2 280 ¢ Roll paper width: 10 inches (254.0 mm) Choose Page Setup from the application menu to
display the Page Attributes dialog box. Rotate Page 90 degrees (Con- Prints by rotating pages by 90 degrees. Click the Finish button. Page 94 Printing on Non-Standard Paper Sizes (Windows) iPF770 Make sure the Main sheet is displayed. Safety Precautions iPF770 Safety Precautions Safety Precautions Safety Precautions ............c.ccccceuneennes 578 Legal
Notices ....cocvvveviiveeiiieeennn, 580 Safety Precautions Safety Precautions Follow the warnings and precautions below to use the printer safely. Access the Page Setup pane. Turn off the printer and wait a while before re- storing power, and then resend the firmware. 286 Starting Free Layout ............cccoevvvnnneene. 286 Free Layout Main Window
.......................... 287 Paper Settings Panel ............................289 Easy Settings ............................290 Advanced Settings ............................ * Layout Area This allows you to lay out objects and edit the object size and orientation. iPF770 Printing Line Drawings and Text (Windows) The printing mode is determined by a combination of the print quality and
resolution. (See "Carriage.") P.436 - Carriage Shaft The Carriage slides along this shaft. Borderless Printing(PowerPoint) iPF770 Select Next. To change the unit cost of a media type that has already been configured, click the Overwrite button. Click Paste from the toolbar. iPF770 Matching Select Color Adjustment. * You can change the numbers by
clicking either A button or ¥ button. iPF770 Setting the Unit Cost for Items Other Than Ink and Paper Enter the Roll Paper Width and Length of the paper, as well as the Price for the configured length. The Features of Free Layout iPF770 Free Layout Free Layout The Features of Free Layout ..............cccceeeunn.e. 570 GL2: W0502 The parameter is out of
range. For more information about Dialog Area, see "Dialog Area." P.172 -... Note For more information, see "Printing on Non-Standard Paper Sizes ."... Setting Details Rotate Right Rotates the object 90 degrees clockwise. Specify additional printing conditions. * Method of Updating Supported Paper Paper that is supported by the printer may be
newly released on the Canon website. Repack the Roll Holder, Holder Stopper, and printer in shipping materials, and then package them in a shipping box. Page 498 Replacing Ink Tanks iPF770 Remove the Ink Tank Open the Ink Tank Cover and check the ink lamps. (See "Dis- playing the Paper Reference Guide.") P.313 - ¢ Get Information Displays
Paper Information on Printer. ¢ After the installation is finished, update the media information by referring to Updating Media Information After Installation P.353 -... iPF770 Deleting Media Types You Have Added Deleting Media Types You Have Added Deleting Media Types You Have Added * Do not attempt to print or turn the printer off while the
program is communicating with the printer. *7: Restrictions apply if a password is configured using Change Password in the Admin. Print Quality Description Highest A setting for printing at the highest resolution when quality is most important. Page 523 iPF770 Reinstalling the Printer Remove tape and packaging material attached to the print-
Connect the power cord to the Power Supply Connector on the right side of the printer. Alternatively, you may select Drawer from the View menu. iPF770 Driver Matching Mode * You can select only after ICC Matching Mode has been selected in Matching Mode. Ether- Auto Detect Specify the communication method. In this case, click Plain Paper.

Click Support. Note ... * After the printer is turned on In other cases, contact your Canon dealer. iPF770 Object Adjustment dialog box: Color * Gray Tone Adjust the color tone of grays as desired. 527 Clearing a Jammed Sheet .......................... 530 Clearing Jammed Paper (Paper Feed Slot) ........c............ Click Print & Scan. 46 Printing enlargements or
reductions ............ Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS) iPF770 If printing is unsuccessful, you may be able to print after completing the following setting. Nozzle Check Nozzle-check settings. For more specific information on restricted items, see "Menu Structure."... (See "Attaching the Roll Holder to Rolls.") P.320
- Load the roll in the printer. In the Page Size list, click the size you registered, My Horizontal Banner. 115 Printing Originals Centered on Sheets .........c............ 117 Printing Originals Centered on Sheets (Windows) .................. 266 Paper Settings Panel .............ccceeeeeenneen. 269 Easy Settings .......ccoevvvvvveinnnnnnn. 270 Advanced Settings ......c.c.ocevvvvevnnnennnn.

Prints using Folded Duplex iPF770 ¢ Only Print Center and Edges To print fold lines at the center and both edges, select the Only Print Center and Edges checkbox. Press A or V¥ to select Interface Setup, and then press the OK button. Select Print Range from All Slides, Current Slide, and Slides. Checking the update iPF770 In the Edit Media Types
dialog box, click the Update button. size" Cause Corrective Action A sheet has come out of the printer during printing. iPF770 View Settings Dialog Box for the Printing Application Roll Paper Margin for Safety You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is held firmly against the
Platen. Page 145 iPF770 Using Favorites Click the Favorites tab to display the Favorites sheet. * Be sure to select the correct paper type. For details on available page sizes, see "Paper Sizes."... How to View Instructions with Navigate iPF770 How to View Instructions with Navigate How to View Instructions with Navigate You can refer to instructions
for loading paper, replacing ink tanks, and performing other operations on the printer control panel. This completes the procedure of switching to Extended position B. Using both hands, rotate the Roll Holder toward the back to rewind the roll. iPF770 Insert the maintenance cartridge. * Number of Pages The number of pages printed. For details on
available printing conditions, see "Printer Driver Settings ." P.248 - Confirm the print settings, and then click Print to start printing. (See "Removing the Roll from the Printer.") P.327 -... Holding the Roll Holder flange (a), remove the holder from the Roll Holder Slot. Cannot adjust paper feed. After confirming that Easy Settings is selected, select
from the Print Target list. Cross-reference in related manuals Example: Refer to the Paper Reference Guide. Printing at Full Size (Mac OS) iPF770 Select the width of the loaded roll in the Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm). iPF770 Printing Originals Centered on Rolls (Mac OS) Select the Print Centered check box. ¢ For
more information on the procedure for opening the Media Configuration Tool main window, see "Media Configuration Tool Main Window." P.379 -... iPF770 HP-GL/2 jobs are printed 6 mm larger than specified HP-GL/2 jobs are printed 6 mm larger than specified HP-GL/2 jobs are printed 6 mm larger than specified Cause Corrective Action The page
size of the HP-GL/2 print job, as created in the source appli- In the Control Panel menu, set PageSizeProcessl to On. "Agitating" is displayed on the control panel. Dialog Box for the Printing Application View set. The created ICC profile needs to be saved in the following folder on the computer you are using. Messages advising to check the
maintenance cartridge are not cleared Messages advising to check the maintenance cartridge are not cleared... Click Image in the Print Priority list. Configuring Units and Display Settings in Accounting Manager iPF770 ¢ You can set unit costs for up to 5 items. Normally, select Driver Matching Mode. | 30 min. Press A or ¥ to select MAC Address,
and then press the OK button. The Printing Wizard dialog box is displayed. ¢ Roll Paper Width The width of roll paper used for printing. Edit and create the document. Page 225 iPF770 Print Using Registered Settings(Word) Click Print Using Registered Settings. Page 127 iPF770 Conserving Roll Paper by Printing Originals Without Top and Bottom

Margins (Mac OS) Click OK to close the dialog box. Printing Paused Printing is paused on the printer. Shape Model number MC-10... Paper Size, and then press the OK button. iPF770 Changing Media Names In the Edit Media Types dialog box, click the Update button. Printhead iPF770 Printheads Printheads Printhead ................cc.cocconne. (Replace
the cartridge when it is full.) Cutter Unit A round-bladed cutter for automatic roll cutting. * You should normally select Update the printer control panel and printer driver. The upper and lower margins can be checked in Print Preview. Close the Top Cover. Paper Retainer Important in supplying the paper. Printing is faint iPF770 Problems with the
printing quality Problems with the printing quality Printing is faint ...........cccccceieiiiniil 538 Paper rubs against the Printhead ........................ 539 The edges of the paper are dirty .........ccoeevvuneeene. 539 The surface of the paperis dirty ......c..ccccvueveennnns 540 The back side of the paperis dirty .........ccoeeevvunneen. Page 486 Troubleshooting Paper Abrasion and Blurry

Images iPF770 Press A or V¥ to select Paper Details, and then press the OK button. Page 288 Free Layout Main Window iPF770 ¢ Menu Bar This allows you to select menus required for operations. Dynamically update the stateless address Dynamically update the manual address Frame Type Use Zeroconf Function MulticastDNS ServiceName
TCP/IPv6 LPD Printing IPv6 settings values. Pull up the Printhead Fixer Cover to open it completely. Page 544 Lines are misaligned iPF770 Cause Corrective Action The type of paper specified in the print- Make sure the same type of paper is specified in the printer driver as you have loaded in er driver does not match the type loa- the printer. Push
the Release Lever back. Note Repeat steps 1 and 2 to complete the settings, and then press the OK button. 03130031-2F7x (x is 0, 1, or 2) You have uploaded firmware for a different model. In the Paper Source list, select how paper is supplied. Yellow Adjust the gray tone. The selected paper is alternately shown or hidden. Confirming Print Settings
iPF770 Access the Main pane. You can choose the settings you have registered from a list before printing, and you can check the settings details. This sheet is used to configure the unit cost of paper. You can change the settings using the Special Settings dialog box. see "Printer Menu Operations." P.406 -... Press the OK button. Follow the
instructions in Replace the Maintenance Cartridge. iPF770 Editing Media Type Information for Genuine Paper and Feed Confirmed Paper Editing Media Type Information for Genuine Paper and Feed Confirmed Paper Editing Media Type Information for Genuine Paper and Feed Confirmed Paper When adding genuine paper and feed confirmed paper
to the printer control panel and printer driver and when edit- ing media type information, click the Add Genuine Paper button in the Media Configuration Tool main window to open the Edit Media Types dialog box. Page 427 iPF770 Status Print Rep.P.head Print Settings after a test pattern was printed following head replace- ment. The printer
automatically switches to the corresponding processing depending on whether a GARO or HP-GL/2 and HP RTL emulation job is received. (See "Device Settings Sheet .") P.168 - Note Six sheets of print settings are displayed by the print- er driver: Main, Page Setup, Layout, Favorites,... If this number is exceeded, jobs are deleted from the log
starting from the oldest record. Page 26 iPF770 User's Guide... 400 How to View Instructions with Navigate ..........cc............ 404 Checking Instructions During Printer Operations ........c........... 405 Printer Menu Printer Menu Operations .........cccceeevueeennnnns 406 Menu Operations ......c.c.ccceeeeeeineennnnnes 407 Menu Structure .......c...ccceeeeevueeennnnns iPF770 User's
Guide Basic Printing Workflow Enhanced Printing Options Windows Software Mac OS Software Handling and Use of Paper Control Panel Printer Parts Network Setting Print Job Management Adjustments for Better Print Quality Maintenance and Consumables Ink Tanks ................... Specifying an Existing Shared Folder as a Hot Folder iPF770 The
hot folder you have created appears in the Hot Folder list in the Color imageRUNNER Enlarge- ment Copy dialog box. iPF770 Printing Enlargements of Scanned Originals from a Color imageRUNNER ¢ The only three sheets displayed are the Main sheet, the Page Setup sheet, and the Layout sheet. Configure Update Target and click the Execute but-
ton. Page Options Dialog Box Page Options Dialog Box This dialog box appears when you select Page Options from the File menu. Page 17 iPF770 Loading and Printing on Rolls Turn the printer on. Note Select Roll Paper Width that is set in the printer. Control Panel Display iPF770 Control Panel Display Control Panel Display After the printer starts
up, the Tab Selection screen is displayed. Otherwise, you may not be able to change displays or operate the tool- Important bar/ribbon. askew, or warped paper (See "Loading Sheets in the Printer.") P.340 - has been loaded. In the Favorites, choose the favorite you registered. Layout Sheet iPF770 ¢ Enables you to register the custom paper size you
have specified or overwrite an existing custom paper size. Page 336 Specifying the Cutting Method for Rolls iPF770 Cut the roll paper manually with scissors or the like. (See "Accessing the Printer Driver Dialog Box from Applications .") P.146 -... Printing with the ink level detection canceled may lead to printer damage and printing problems. Page
255 iPF770 Main Pane ¢ Print Priority Choose the graphic elements that you want to emphasize for printing. Page 306 Aligning Objects iPF770 ¢ Center Vertically Lays out the objects, justifying them to the verti- cal center. Agitate the ink in the Ink Tank by slowly rotating the Ink Tank upside-down and right side up repeatedly. DNS SrvAddr face
Settings DNS Host Name Specify the DNS host name. Portrait Orientation/Landscape Orientation(Word) iPF770 Portrait Orientation/Landscape Orientation(Word) Portrait Orientation/Landscape Orientation(Word) Print to the edge of the roll width. Click the Create Page button. Page 588 Chcete-li ziskat podrobné informace tykajici se recyklace
tohoto vyrobku, obratte se prosim na mistni irad, organ pro naklddani s odpady, schvaleny systém nakladani s odpady ¢i spole¢nost zajistujici likvidaci domovniho odpa- www.canon-europe.com/weee www.canon-europe.com/battery du, nebo navstivte webové stranky nebo -... The roll is empty. * You can input between 1 and 10. When the media you
chose is different from the media set in the printer, you may not receive the desired print results. Page 6 Matching pane ..........cccc.ccvvevennnn.n. 258 Color Settings Pane: Color .........c..ccvuneeeennnes 260 Object Adjustment dialog box: Color ............ccu......... 462 Job Management Using imagePROGRAF Status Monitor ................ 463 The Features of imagePROGRAF
Status Monitor The Features of imagePROGRAF Status Monitor imagePROGRAF Status Monitor is a utility for checking the printer status and managing print jobs. Open the Output Stacker Ejection Guides (a). To start from Microsoft Excel iPF770 Edit and create the document. « Media Type/Paper Source/Paper Size You can confirm the information
that is set. (See "Paper Sizes.") (See "Types of Paper.") P.310 P.310 - - Note Turn the printer on. iPF770 Page Setup Sheet Page Setup Sheet Page Setup Sheet The following settings are available on the Page Setup sheet. Call for service." is shown on the Display Screen and preparation is not possible. The Roll Holder in the Roll Holder Set RH2-33
is for use with both 2-inch and 3-inch paper cores. Page 510 Replacing the Maintenance Cartridge iPF770 If a message is displayed requesting Maintenance Cartridge replacement, you can skip the step Access the menu for Maintenance Cartridge replacement. In the Media Type list, select the name of the media to switch off or on for display. Page
409 iPF770 Menu Operations Press the A or ¥ button to enter the value. Page 273 iPF770 Output Settings Panel Setting Details Scaling Enlarges/reduces the whole page by the scaling rate as specified. Color (CAD) 3 Print with approximate colors emulating Canon iPF500, iPF600, iPF700, iPF510, iPF610, iPF710, iPF605, iPF720, iPF810, iPF820,

iPF815, iPF825. It takes about seven minutes to complete. 179 Starting Free Layout .........c.cccvveevvnnneenn. 179 Free Layout Main Window ...............ccceeeeennes 181 Detailed Settings ........ccceevvvvneennnnnnn. 182 Preferences Dialog BOX ........ccceevvneennnnnen. 183 Page Options Dialog BOX .........ccceevvvneeennnnes 184 Zoom Dialog BoX ........ccceevvveneennnnnnn. Page 352 Installation
Procedures iPF770 Start the Media Configuration Tool installer. Page 590 Za vec¢ informacij o ponovni uporabi tega izdelka se obrnite na lokalen mestni urad, pristojno sluzbo za odpadke, predstavnika pooblas¢enega programa za obdelavo odpadkov ali na lokalno komunalo. Menu Structure iPF770 Menu Structure Menu Structure The menu structure
is shown categorized by tab. Straighten out curls and reload the roll. Holder Stopper Secure rolls on the Roll Holder with this part. Front iPF770 Printer parts Printer parts Front ...........ccc.cooeeevinn. 432 Side ..oevieeiieeeieeeiee, 434 Top Cover (Inside) ......ccoeeevvneevvnnnnnnnn. 435 Roll Cover (Inside) ......ccoceevvneevrnnnnnnnn. 436 Carriage ....ccooeevveeeveeeeiieeennnnns Click

the Add Genuine Paper button in the main window, and then click the Add button in the Edit Media Types dialog box. Driver Matching Mode iPF770 ¢ You can select only after ICC Matching Mode has been selected in Matching Mode. Important ¢ Printing is done in Print Matching Roll Width of the Printing Wizard. Note * When setting a data to the
printer that differs from the data to be updated, the selected media informa- tion file is updated. iPF770 Showing, Saving and Loading Selected Unit Cost Data Showing, Saving and Loading Selected Unit Cost Data Showing, Saving and Loading Selected Unit Cost Data « Show Unit Cost Data Select Show Unit Cost Data in the File menu to open the
Unit Cost Data dialog box. Select the folder that contains the media information file (.amx file) you downloaded and click the Open button. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon. (See "Displaying the Paper Reference Guide.") Types of paper in the printer driver and related software (as well as on the Control Panel ) are
P.313 »... Page 321 iPF770 Attaching the Roll Holder to Rolls ¢ For details on supported sizes and types of rolls, see Paper Sizes or the Paper Reference Guide. Make sure the paper you select is loaded in the printer. iPF770 User's Guide Basic Printing Workflow Enhanced Printing Options Windows Software Mac OS Software Handling and Use of
Paper Paper ......ccc.cceeenne. 310 Handling rolls .................. 320 Handling sheets ................. » Dialog Area This allows you to set the print conditions and perform a print job. 2014... » Page Size Select the page size as specified in the source application. iPF770 User's Guide Basic Printing Workflow Enhanced Printing Options Windows Software Printer
Driver .................. 140 Preview .......cccoeeevennn. 169 Free Layout .................. 179 Color imageRUNNER Enlargement Copy ......... iPF770 Troubleshooting Paper Abrasion and Blurry Images Examine the test pattern for adjustment. This is a standard feature of the operating system. If you select No, you will return to the applica- tion. iPF770 Borderless
Printing on Paper of Equivalent Size Borderless Printing Borderless Printing Borderless Printing on Paper of Equivalent Size .................... 77 Borderless Printing by Resizing Originals to Match the Paper Size (Windows) .......... 78 Borderless Printing by Resizing Originals to Fit the Roll Width ................ 80 Borderless Printing by Resizing Originals to Fit
the Roll Width (Windows) ............ Doing so may cause the ink to leak out. 548 Lines are printed too thick or thin in HP-GL/2 print jobs .................. iPF770 Printing on Non-Standard Paper Sizes Confirm the print settings, and click Print to start printing. Page 387 iPF770 Changing Media Names Click the Add Genuine Paper button in the Media
Configuration Tool main window. Paper Detailed Settings Dialog Box iPF770 ¢ To display the Paper Information on Printer dialog box, on the Main sheet, click Get Information by Media Type. Roll Holder Slot Load the Roll Holder into this holder slot. Printing Office Documents (Mac OS) iPF770 After confirming that Easy Settings is selected, click
Office Document in the Print Target list. For more information about No Spaces at Top or Bottom, see "Not Print Spaces at the Top/Bottom." P.178 -... The firmware version is displayed. Reinstalling the Printer iPF770 « The Stand must be assembled by at least two people on a flat surface. Page 160 Page Setup Sheet iPF770 » Enlarged/Reduced
Printing Choose from the following options when this setting is activated. (See "Dis- playing the Paper Reference Guide.") P.313 - ¢ Displays Paper Detailed Settings. Also, select the media size to print. * We recommend exiting unnecessary applications before printing. Page 217 iPF770 To start from Microsoft Word Check that the imagePROGRAF
Print Plug-In toolbar/ ribbon is displayed. ¢ Brightness Adjust the overall image brightness as desired. Press A or ¥ to select Roll Length, and then press the OK button. At this time, position the holder so that the R label (c) on the [W label (c) on the Roll Holder flange is aligned with the R label (d) on the printer . iPF770 Canceling Print Jobs from Mac
OS Right-click the job to cancel and select Cancel. Here, enter 430 mm in Height and Width. ¢ After installing an ink tank, do not remove and shake it. Page 176 Printing with Selecting the Layout iPF770 Button Details Lower Button Turn at the position of * Right Button or Left Button can be selected only when the rotated pages can fit lengthwise
across the roll. Page 384 If the following message is displayed, configure the settings by using the following procedure. EEE. Power button immediately to switch the printer off, unplug the printer power cable from the outlet, and then contact your Canon dealer or support center. To use newly released paper, register the latest paper information on
the printer with the Media Configuration Tool. iPF770 To start from Microsoft PowerPoint Adjust Length from the list-box or slide-bar. Pasting a Copied or Cut Object iPF770 « Bring Forward Moves the object one position to the front. Page 318 Updating paper information iPF770 Click Utility. Ink now fills the system. Configuring Binding (Excel)
iPF770 « If data analysis requires time, a message dialog will appear. 99 Centering originals.............. 113 and so on Windows Software... Page 221 iPF770 Borderless Printing(Word) Select Roll Paper Width that is set in the printer. In this case, the paper can be edge of the paper is cut during printing. After the Display Screen shows the Canon logo,
"Starting up... Page 402 Control Panel Display iPF770 Display Transitions in Normal Status The display transitions while the printer is in the normal status (the status where no errors have occurred) are shown below. Page 478 iPF770 User's Guide... The Layout menu will appear automatically. * When handling the Printhead, always hold it by the
grips (a). 514 Cleaning Inside the Top Cover .........cccc.ccuun..... 514 Cleaning the Printhead ........................... iPF770 Reinstalling the Printer Tape down printer covers to secure them, in the reverse or- der of tape removal during installation. Select a country or territory then click the Next but- ton. Side iPF770 Side Side Manual Pocket Store printer
manuals in this pocket. 346 Media Configuration Tool (Windows) .......... 351 Media Configuration Tool (Mac OS) .......... 326 Removing the Roll from the Printer ......................... iPF770 When to Replace the Maintenance Cartridge If the Display Screen indicates to replace the Maintenance Cartridge, replace the Maintenance Cartridge. Loading Sheets
in the Printer iPF770 Handling sheets Handling sheets Loading Sheets in the Printer ........c....cccccceeunnie Shape Model number PF-04 « For instructions on replacing the Printhead, see "Replacing the Printhead." P.504 -... Select the Open Preview When Print Job Starts check box. In regular printing, a margin required by the printer is added around the
original. 524 Preparing to Transfer the Printer Preparing to Transfer the Printer To protect the internal parts in transit, always follow these steps before transferring the printer to a new location. Check the message and press the p button. Page 324 Loading Rolls in the Printer iPF770 ¢ Do not force the Roll Holder into the printer with the right and
left ends reversed. Click the Nextbutton. 310 Paper Sizes ........ccccccevvvevinnrennnnnns 310 Using Paper Other Than Genuine Paper and feed confirmed Paper ............... This allows you to configure the roll paper length, object layout order, and margins of Free Layout. ¢ For tips on confirming print settings, see "Confirming Print Settings ." P.143 ->... ¢
Favorites Registering a favorite for later use. Checking Ink Tank Levels iPF770 Push the Ink Tank Lock Lever closed until it clicks into place. * The job serial number. Page size: A4 (210.0x297.0 mm)/Letter (8.3 x 11.7 in) Paper: Roll ¢ ¢ Paper type: Canon Glossy Photo Paper 170gsm ¢ Roll paper width: 10 inches (254.0 mm) Choose Page Setup from
the application menu to display the Page Attributes dialog box. Important Clear any jammed paper from inside the Top Cover. iPF770 User's Guide Basic Printing Workflow Enhanced Printing Options Windows Software Mac OS Software Handling and Use of Paper Control Panel Printer Parts Printer parts .................. 432 Optional accessories
................. Magenta Adjusts the strength of colors to compensate the hues. Giving Priority to Particular Graphic Elements and Colors for Printing iPF770 Click OK to close the Color Settings dialog box. 170 Dialog Area ..............................172 Enlarge/Reduce the screen display ......................... Attempting assembly by yourself poses a risk of injury or
bending the Stand. ¢ Print Job Start Time/Print Time The time when printing started and the time taken to print. From the list on the left side of the options dialog box, select Add-ins. Specifying Colors and Printing CAD Drawings (Windows) iPF770 For instructions on configuring Color Compatibility, refer to the following topics. Page 259 iPF770
Matching pane Driver Matching Mode The following options are available when you select Driver Matching Mode in the Matching Mode list. Click the Matching Method list, and then select a setting. (See "Accessing the Print- er Driver Dialog Box from Applications .") Page 30 Make sure the Main sheet is displayed. You can print large exhibits and
posters, and also print Portrait and Landscape orientations made in Large-Format Printing Wizard. Page 109 iPF770 Printing Multiple Pages Per Sheet (Mac OS) ¢ Page Setup might not be displayed in the menu de- pending on the OS you are using and the applica- Note tion software. Setting Details Print Quality... iPF770 Menu Structure *1: For
information on the types of paper the printer supports, refer to the Paper Reference Guide. Stand iPF770 Stand Stand ¢ Printer Stand ST-34 Accessory Pocket Stores printer accessories. * For tips on confirming print settings, see "Confirming Print Settings ." P.250 -... Trademarks ¢ Canon, the Canon logo, and imagePROGRAF are trademarks or
registered trademarks of CANON INC. iPF770 Changing the Type of Paper Holding it at the positions indicated, close the Roll Cover. Push the scrap out toward the Platen. Page 484 Adjusting Line Misalignment iPF770 ¢ If the Tab Selection screen is not displayed, press the Menu button. Page 362 Adding Media Types iPF770 Copy the downloaded
media information file (.amx file) to the computer where the Media Configuration Tool is installed. Canon cannot guarantee the accuracy of these estimates. Page 267 iPF770 Preview Main Window ¢ You can use the View menu to show or hide the tool bar. iPF770 Printing Multiple Pages Continuously (Windows) * Banner Printing ¢ This feature is only
available with rolls. Note Select Specify the Media Information File in the Add Media Type dialog box, click the Browse but-... Click the Layout tab to display the Layout sheet. This may damage the Printhead and affect printing quality. Since the software (Web server) for using RemoteUTI is built in the printer, preparing software other than a Web
browser is unnecessary. Before moving the printer, always unlock all four casters. Changing the Display Order of Media Types iPF770 In the Edit Media Types dialog box, click the Update button. Select the printer in the dialog box, and then open the printer driver dialog box. Menu Settings iPF770 Menu Settings Menu Settings Menu items are as
follows. If the Display Screen indicates to replace the Ink Tank, replace the Ink Tank. Page 3 Resizing Originals by Entering a Scaling Value (Mac OS) .................. 65 Printing at full size Printing on Oversize Paper ........ccccceevvnevvnnnnen. 68 Printing at Full Size (Windows) ........cccccevvevennnnn. 69 Printing at Full Size (Mac OS) ......cccoeevvvneennnnnns 70 Borderless
Printing at Actual Size ........c..ceevuveennnne. 72 Borderless Printing at Actual Size (Windows) ..........cccceeeeuenns If Pages is selected, enter the number of pages. However, this takes more time than regular printing. Press the tip of the Ink Tank Lock Lever of the color for re- placement horizontally and pull the Ink Tank Lock Lever up to open it. * Normally,
select Print from the File menu. Page 385 iPF770 Adding Media Types Select Specify the Media Information File in the Add Media Type dialog box, and then click the Browse button. 457 Configuring the IP Address Using the Printer Control Panel ............... (See "Updating paper information.") P.316... * Available only if rolls are selected in Paper
Source. P.269 -... The Features of imagePROGRAF Printmonitor iPF770 Printmonitor (Mac OS) Printmonitor (Mac OS) The Features of imagePROGRAF Printmonitor .................... 464 Job Management Using imagePROGRAF Printmonitor ................... This allows you to configure the prefer- ences of Free Layout. 560 This paper cannot be
USed..uueiiieenineeinnnenns 559 This type of paper is not compatible with HP-GL/2. Do not use numbers, -, or . Execute printhead cleaning. Click Utility. 502 Checking for Nozzle Clogging .......c....ccceeeevunnes Page 114 Printing Originals Centered on Rolls (Windows) iPF770 Make sure the Main sheet is displayed. 398 Control Panel Display .........c.cccccuuveevunneen. .
You can input between 0.0 and 50.0(mm) (between 0.00 and 1.97(inch)). Checking the Layout in a Preview Before Printing iPF770 Checking Images Before Printing Checking Images Before Printing Checking the Layout in a Preview Before Printing Checking the Layout in a Preview Before Printing You can check the print layout on the preview
screen. Page 420 Print with approximate colors emulating Canon iPF750, iPF755, iPF650, iPF655, iPF760, iPF765. Contact your Canon dealer for assistance. ¢ Print Button Click the button to begin printing. Print on the Center iPF770 Print on the Center Print on the Center You can print on the center of the media loaded in the printer. To enable
automatic cutting, click Printer Default in the Automatic Cutting list. iPF770 Color Adjustment ¢ Print Button Click the button to begin printing. * If a print job was received The printer now starts printing the print job. Job List Area Job List Area The job items and details that can be displayed in the job list area are as follows. In Non-Printable Area,
enter 5 for the top and side margins and 23 for the bottom margin. You can adjust the brightness if the printed document is lighter or darker than the original image (that is, the original photo that was scanned or the original graphic as it ap- pears on the computer screen). 464 Accounting (Windows) ............... iPF770 Laying out a Document Created
with Multiple Application Programs on One Page Leaving Free Layout running, open other files with the application software and repeat the above steps. Start Microsoft Word. Press A or ¥ to select TCP/IP, and then press the OK button. iPF770 Favorites Sheet ¢« Fast Graphic Process Turning this setting on may help produce the expected results if
image colors are inconsistent in printed docu- ments or if lines are printed in varying thicknesses. Page 418 10. | 1 min. Configuring the IP Address on the Printer iPF770 Initial Settings Initial Settings Configuring the IP Address on the Printer ....................... * When the objects are not selected, you can not select Format. iPF770 Execute printhead
cleaning. I'a meploodTEPEG MANPOPOPIEC OYETIKA € AVAKDKAWGOT LTOD TOL IPOIOVTOC, EMKOIVWVNOTE PE TO TOMKO ypa@eio Tng mMOANG 0AG, TNV LONPECIN ATOPPIIPATWDY, TO EYKEKPLPEVO OYNPA 1) TNV LINPECTX AIOPPLYNG OKLOKWD ammoBANTwD N emoke@Oeite tn 61€00LVGN www.canon-europe.com/weee 1) www.canon-europe.com/battery - -... Enter the
folder shared name in Shared Name. * Note To cancel printing the test pattern for adjustment, hold down the Stop button. iPF770 User's Guide Basic Printing Workflow Enhanced Printing Options Windows Software Mac OS Software Printer Driver .................. 248 Preview .......c..cceeeeeeee. 265 Free Layout .................. 286 Printmonitor ................. 453
Configuring the Destination in TCP/IP Networks Configuring the Destination in TCP/IP Networks If you use the printer in a TCP/IP network, register the printer in Print &... Remove the Stand by reversing the installation procedure, when it was attached to the printer. Select Print Range from All Pages, Current Page, and Pages. * You can also move a
page by clicking the page on the thumbnails. Note * Recommended Print Area: We recommend printing within this area. Page 349 iPF770 Using the Output Stacker Grasp the Output stacker handle (a) and pull out the Output Stacker so that it tilts towards you. Do not perform any operations or procedures other than as described in this manual. Page
317 Canon website is displayed. Page 62 Resizing Originals to Fit the Roll Width (Mac OS) iPF770 « Paper type: Plain Paper Roll paper width: 16 inches (406.4 mm) * Choose Page Setup from the application menu to display the Page Attributes dialog box. Choose Protocol Settings from the Printer menu. Page 237 iPF770 Portrait
Orientation/Landscape Orientation(PowerPoint) Click Paper Settings from the imagePROGRAF Print Plug-In toolbar/ribbon. ¢ A button Press this button in the menu to move to another item. ¢ Drawer Area This allows you to display the thumbnails of a document. 466 Adjustments for Better Print Quality Maintenance and Consumables
Troubleshooting... ¢ If paper would be short when cut at a particular position, the roll may automatically be advanced in some cases before cutting. 173 Using the ruler ............cccccceeeeeennee. 173 Priority setting for rotating 90 degrees .......ccc............ Gateway Address LPD Printing IPP Printing IPP Printer URI RAW Printing Raw Mode Bi-direction FTP
Printing WSD Printing Use Discovery Scope Primary DNS Server Address Secondary DNS Server Address DNS Host Name DNS Domain Name MulticastDNS ServiceName SNMPv1... Select the print target in the Print Target list. In the Page Size list, click the size of the original as specified in the application. Moving the printer while casters are
locked may scratch the casters or the floor. iPF770 Printing Originals Centered on Rolls Centering originals Centering originals Printing Originals Centered on Rolls ........................ Dal$ie informécie o recyklacii tohto produktu ziskate od miestneho tradu, uradu Zivotného prostredia, zo schvéle- ného planu OEEZ alebo od spolo¢nosti, ktora zaistuje
likvidaciu komundélneho odpadu. The printer menu is classified into regular menu items available when no print job is in progress and menu during printing items only available while printing is in progress. Page 413 iPF770 Menu Structure First Level Second Level Third Level Fourth Level Fifth Level Sixth Level Seventh Level Eighth Level PageSize-
Off* | On Processl PageSize- Off* | On Process2 GL2 Set Print Interface EOP Tim- 10 sec. In this case, click 10"x12". Contents Basic Printing Workflow Printing procedure Printing Options Using Rolls and Sheets ............ccc......... 14 Turning the Printer On and Off .......................... 15 Loading and Printing on Rolls ............ccoeveennnnee. Loading Rolls in the
Printer iPF770 With the edge of the roll paper facing forward as shown, in- sert the Roll Holder from the right of the roll. Setting Details Enables printing of optimal color tones using a driver specific color profile. Adjusting the Printhead iPF770 Adjusting the Printhead Adjusting the Printhead Adjusting the Printhead .......................... 480 Automatic
Adjustment to Straighten Lines and Colors ................ 480 Manual Adjustment to Straighten Lines and Colors .................. 481 Adjusting Line Misalignment ...............ccceeevenne. Color Adjustment Sheet: Color Color Adjustment Sheet: Color If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment sheet. Conserving Roll
Paper by Printing Originals Without Top and Bottom Margins iPF770 Access the Page Setup pane. Roll paper cannot be inserted into the Paper Feed Slot Roll paper cannot be inserted into the Paper Feed Slot Cause Corrective Action The roll paper is warped. ¢ If you repeat these steps several times but the horizontal lines are still faint or incomplete,
the Printhead may have reached the end of its useful life. * When several objects are selected, you cannot display Object Size. iPF770 Roll Holder Set Optional accessories Optional accessories Roll Holder Set Roll Holder Set Load a roll on the roll holder and then load the holder in the printer. Sec. * When storing printed documents on the Output
Stacker Use position (1). Page 24 Canceling Print Jobs from Mac OS iPF770 If there are no jobs to stop in the printer window (if sending the print data to the printer has finished), ei- ther click Settings, Utility, and then Open Printer Utility, or click Utility to open the imagePROGRAF Printmonitor. The printer control panel and printer driver media in-
formation is updated. On the Color Adjustment pane, adjust the color tones, brightness, and so on as desired. Cause Corrective Action The print job received specifies a Follow these steps to change the settings of the print job to enable borderless printing. 58 Resizing Originals to Match the Paper Size (Windows) ................ 58 Resizing Originals to Fit
the Roll Width ...........cc.cooe..e. 60 Resizing Originals to Fit the Roll Width (Windows) .................. Color imageRUNNER Enlargement Copy Dialog Box iPF770 The Color imageRUNNER Enlargement Copy dia- log box displays. Click in the Edit Using PosterArtist in the Page Layout list. Multi-sensor error Multi-sensor error... If items of the menu list are
more than the lines of the screen, press A and V¥ to scroll the menu. ¢ The titles of dialog boxes may vary depending on the application, and sheets other than these six sheets may be displayed. Page 53 iPF770 Giving Priority to Particular Graphic Elements and Colors for Printing The printing mode is determined by a combination of the print quality
and resolution. If this happens, install the .NET Frame- Note work by following the procedure. Select Media Type. Dialog Area Dialog Area You can select the layout and print on the center. Page 374 Tool.pkg to start the Media Configuration Tool installer. Page 482 Manual Adjustment to Straighten Lines and Colors iPF770 « We recommend using the
type of paper you use most often for adjustment. Click the Browse botton, with selecting Specify a folder, to set the existing shared folder. Select an object. * Without closing the Canon imagePROGRAF Free Layout window, repeat steps 1 to 4 to arrange origi- nals from multiple applications on the same page. Note Close the Ink Tank Cover. ¢ Page
Setup might not be displayed in the menu de- pending on the OS you are using and the applica- Note tion software. iPF770 Printing at Full Size (Windows) ¢ Printing at Full Size (Windows) P.69 - ¢ Printing at Full Size (Mac OS) P.70 - Printing at Full Size (Windows) Printing at Full Size (Windows) This topic describes how to print at full size based
on the following example. iPF770 Error Messages Error Messages Borderless printng not possible........................ 563 Cannot adjust paper feed...........c.covunennnns. 566 Cannot adjust printhead...................c...... 567 Cannot detect ink level correctly. Cause Corrective Action When Detect Mismatch in the Control Panel Press A or ¥ to select Print, and then
press the OK button to resume printing. Page 5 Laying out a Multiple-File Document on One Page .................... 187 Laying out a Document Created with Multiple Application Programs on One Page .......... 189 Selecting an Object .......cccevvvvvneevnnnnnnne. 191 Changing the Object Size .......cccevvvvvvneennnnns 191 Moving an Object .......ccceevvveeivinnnnnn. 192 Rotating an
Object coovveveiiiiiiiiiiin, The installation for Print Plug-In for Office is com- plete. (See "Setting the Print Parameters.") P.208 - Click the OK button to close the Add/Edit Hot Fold- er dialog box. Register the settings (PowerPoint) iPF770 Select Media Type. Note Press the OK button. Borderless Printing at Actual Size iPF770 Borderless Printing at
Actual Size Borderless Printing at Actual Size Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) without a surrounding margin, or border. Page 12 No ink tank loaded.................ccvuveeennn.. 565 Check if ink tank is set, and its color and direction.................... 565 The following ink tanks cannot be
recognized...................... 565 Do not pull out ink tank...........c.cceeeennnnn.n. 565 Messages regarding printing or adjustment Cannot adjust paper feed. Note * By clicking Right Button or Left Button, you can save paper by printing in landscape orientation on roll paper. In Layout Selection, click the layout button to use. Printing on Non-Standard Paper Sizes
(Mac OS) iPF770 Click Custom Size in the Page Size list to display the Custom Size Settings dialog box. Select the type of printer to use. ¢ If the Ink Lamp is not lit, reinstall the tank. Setting Details Cyan Adjusts the strength of colors to compensate the hues. Print Matching Roll Width(Word) iPF770 Large-Format Printing Wizard dialog box ¢ If you
want to change the display to another file or application while the Large-Format Printing Wizard is open, close the Large-Format Printing Wizard dialog box. Click the System Preferences icon in the Dock. PaprWidth Mismatch iPF770 Cause Corrective Action The loaded paper is too small. iPF770 Selecting an Object Selecting an Object Selecting an
Object When an object is selected, a select box (blue border) appears around the object. Choose Cool (tinged with blue) or Warm (tinged with red). Hardware error. Page 92 Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS) iPF770 Access the Main pane. Page 240 Print Entire Sheet(Excel) iPF770 If a print area is set, a
confirmation message dialog box will appear. To download it manually, access the Canon website. Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS) iPF770 Make sure the Main sheet is displayed. Automatic Banding Adjustment iPF770 On the Tab Selection screen of the Control Panel, press « or p to select the Settings/Adj. iPF770
Print Page Rotated 90 Degrees Print Page Rotated 90 Degrees Print Page Rotated 90 Degrees You can save paper by printing in landscape orientation on roll paper. Settings for Portrait or Landscape Orientation can be set. A:High ¢ This setting is applied when Highest or High is selected in Print Quality in the printer driver. Page 207 iPF770
Specifying an Existing Shared Folder as a Hot Folder The Add/Edit Hot Folder dialog box displays. * Note To select multiple successive objects, click them while holding down the Shift key. curred in the Push the Release Lever back and remove the jammed paper. If you continue to use the printer, this could cause a fire or electrical shock. Adjusting
Color Normally colors should be adjusted in the software application, but if you see colors in the printout that do not match colors on the screen, you can perform color adjustments. Click Open Printer Utility. iPF770 Register the settings (Word) Select Next. « You cannot click the Binding Settings button in the following situations. Click Set to display

the Paper Detailed Settings dialog box. 567 Execute printhead cleaning...........c....cc.u.. ... 568 Cannot adjust printhead. 496 Printheads .................. The margin for the trail- ing edge of sheets is 23 mm (0.9 in). MaintCart, keeping it level. This completes the installation of Media Configuration Tool. The restriction states and main items are shown below.
» Attaching the Roll Holder to Rolls P.320 = ¢ Loading Rolls in the Printer P.322 - * Loading Sheets in the Printer P.340 - * Always make sure the loaded paper matches the type of paper specified. Up to 31 characters can be entered. Icon Contents Displays the About, Help, and Special Settings dialog boxes. Detailed Settings Detailed Settings The
printer driver opens when you select Detailed Settings from the File menu. End of paper feed. 509 Replacing the Maintenance Cartridge ...................... 509 Checking the Remaining Maintenance Cartridge Capacity ................ 512 When to Replace the Maintenance Cartridge .................... 513 Maintenance Cartridge Maintenance Cartridge When

purchasing, check the Model number. iPF770 Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) By automatic enlargement of a document created with an application software by
the printer driver, you can print maximum 18.0 m vertical or horizontal banners. Dialog Box for the Printing Application iPF770 View set. is not liable for any damage that may occur as a result of refilling ink. Frequency Warning Use USB Use USB settings values. this printer. Note Accessing the Printer Driver Dialog Box from Applications Accessing
the Printer Driver Dialog Box from Applications... iPF770 Messages regarding HP-GL/2 Messages regarding HP-GL/2 This type of paper is not compatible with HP-GL/2.................. 570 GL2: Wxxxx The memory is full. *4: Not displayed if IPv4 Mode is Manual. Layout Sheet Layout Sheet The following settings are available on the Layout sheet. 464 -
Media Configuration Tool ............. Page 311 iPF770 Paper Sizes Roll Width Roll Paper Width Setting in Printer Driver Borderless Printing ( *1 ) 609.6 mm (24.00 in) 24-in. Page 507 iPF770 Replacing the Printhead Holding the new Printhead by the grips (a), remove it from the pouch. Push all ink tank lock levers closed until they click into place. You
can set the preferences for Free Layout. iPF770 Folded Duplex Window Folded Duplex Window Folded Duplex Window This window is displayed if you select Folded Duplex from the Edit menu after selecting an object. For details on downloading and updating the firmware, visit the Canon web- site. Page 7 Handling and Use of Paper Paper Types of
Paper ....ccoovveiiiiiiiiniiin iPF770 Job Management Using imagePROGRAF Printmonitor Job Management Using imagePROGRAF Printmonitor Job Management Using imagePROGRAF Printmonitor You can use the Driver Panel in imagePROGRAF Printmonitor for operations such as pausing and canceling print jobs. Select the printer in the list and
click Delete. On the Printer Status sheet, click Cancel Job. Page 511 iPF770 Replacing the Maintenance Cartridge At this point, open the Maintenance Cartridge Cover. Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other countries. Click Add to display the Add dialog box. Page 98 Printing on Non-



Standard Paper Sizes (Mac OS) iPF770 Access the Page Setup pane. Moving a Page Moving a Page You can move a page to display in the preview area. The following settings are available on the Device Settings sheet. Return to the regular position. Actual size is displayed. Preview Main Window Preview Main Window The Preview main window
consists of the menu and tool bars, and preview, dialog , drawer and status area. Printing Line Drawings and Text (Mac OS) iPF770 Click the Page Setup tab to display the Page Setup sheet. Normally, select Auto Settings. iPF770 Configuring the IP Address Using ARP and PING Commands Press the OK button. Page 421 iPF770 Menu Settings Setting
Item Description, Instructions Paper Paper Source Choose the source of paper for HP-GL/2 printing. Click the Yes button. iPF770 Printing from Mac OS Printing from Mac OS Printing from Mac OS Print from the application menu after registering the printer. Note When you attempt to print, PosterArtist starts up and the PageCapture window is
displayed. Important Registering the printer The printer needs to be registered in Print &... iPF770 Printing Multiple Originals Next to Each Other Tiling and multiple pages per sheet Tiling and multiple pages per sheet Printing Multiple Originals Next to Each Other .................... 99 Printing Multiple Originals Next to Each Other (Windows)

................ 100 Printing Multiple Originals Next to Each Other (Mac OS) ................101 Printing Multiple Pages Continuously ...................... Click . Setting Standard Prices Select the media type in Media Type. iPF770 Object Adjustment dialog box: Monochrome Object Adjustment dialog box: Monochrome Object Adjustment dialog box: Monochrome In
the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. 465 The Features of imagePROGRAF Printmonitor The Features of imagePROGRAF Printmonitor imagePROGRAF Printmonitor is a utility for checking the printer status and managing print jobs. ICC Matching Mode iPF770 ICC Matching Mode ICC
Matching Mode Under Matching Mode, select ICC Matching Mode. * Specifying Colors and Printing CAD Drawings (Windows) P.44 - Specifying Colors and Printing CAD Drawings (Windows) Specifying Colors and Printing CAD Drawings (Windows) You can complete color settings when Color (CAD) is selected in Color Mode. Manuals for this printer
iPF770 Manuals for this printer Manuals for this printer Manuals for this printer .........cc...ccoeeeeennnis Click the Exit button. Check the connection at the plug and electrical outlet. iPF770 Canceling Regular Print Job Log Acquisition * Immediately after you configure Regular Data Acquisition, no print jobs are displayed. Page 75 Borderless Printing at
Actual Size (Mac OS) * Paper: Roll Paper type: Canon Glossy Photo Paper 170gsm ¢ * Roll paper width: 10 inches (254.0 mm) Choose Page Setup from the application menu to display the Page Attributes dialog box. iPF770 Paper Information on Printer Dialog Box * Highest quality When the check box is selected, printing is performing focusing on
quality. Select the printer in the Select Printer dialog box, and then click the Next button. * Do not attempt to print or turn the printer off while the program is communicating with the printer. | 2 min. Page 593 Index Accounting .......... 466, 467, 470, 474 Orientation ........ 131, 132, 133, 226, 236 Adjusting the Color in the Printer Driver ...... 46 Oversize
.............. 68 Adjusting the Vacuum Strength ........493 Page Setup Pane ............263 Bonjour Network ............453 Page Setup Sheet ............ Select the Watermark check box. Dialog Area iPF770 « Status Bar This shows the message, Pages and Output Size. | 60 min. The Paper Menu is displayed. Display with Actual Size Display with Actual Size In the
preview area, you can display the actual size. Printing From a Desired Starting Point iPF770 Press the OK button. The remaining ink level is indicated as shown below. Ink Tanks iPF770 Ink Tanks Ink Tanks Ink Tanks .........cccccceerieeiiuinnaee. Configuring TCP/IPv6 Network Settings iPF770 The Set./Adj. If an original comprises images, graphics, and text,
you can specify which portion to apply color adjustment to. iPF770 Changing the Display Order of Media Types * You should normally select Update the printer control panel and printer driver. TrimEdge Reload Specify whether to trim the leading edge of the currently retracted roll when the roll is advanced. Page 528 Clearing Jammed Roll Paper
iPF770 Push the Release Lever back. iPF770 Printing Originals Centered on Sheets Printing Originals Centered on Sheets Printing Originals Centered on Sheets You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reduc- ing the original. 405 Control Panel Control Panel Display Screen Shows
printer menus, as well as the printer status and messages. Select the printing application in the Print Target list. The carriage serves a key role in printing. If Slides is selected, enter the slide number. Open the Top Cover and move the Angle Adjustment Lever to match the number (or the square) of the straightest set of lines. The printer now
initializes the Maintenance Cartridge. Page 360 When a newer version of media information file than the media information file that is applied to your printer driver is released on the Canon website, the message on the right is displayed. Laying out Objects Automatically Laying out Objects Automatically Click Auto Arrange Object in the tool bar. Page
19 iPF770 Loading and Printing on Sheets ¢ For details on supported types and sizes of paper, see Paper Sizes or the Paper Reference Guide. View set. Page 268 Preview Main Window iPF770 ¢ Dialog Area This allows you to set the print conditions and perform a print job. Page 257 iPF770 Paper Detailed Settings Dialog Box Roll Paper Margin for
Safety You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is held firmly against the Platen. (Oversized Printing) ¢... Page 430 Printing Interface Setting Reports iPF770 TCP/IPv6 IPv6 settings values. Page 429 iPF770 Printing Interface Setting Reports TCP/IPv4 IPv4 settings values. Preview
Main Window Preview Main Window The Preview main window consists of the menu and tool bars, preview and dialog area and status bar. Note If the message on the right is displayed, the media °... | 1 hour | 4 hours | 8 hours* | 12 hours Timer Buzzer Off | On*... Note Configuring Units and Display Settings in Accounting Manager Configuring Units
and Display Settings in Accounting Manager Select Units and Display in the Settings menu to open the Units and Display dialog box. Page 391 iPF770 Switching Media Types Display Show/Hide Click the Add Genuine Paper button in the Media Configuration Tool main window. ClickOK if the message is displayed. 545 Cannot print over a TCP/IP
network .......coceeveeennnnnn. In menu items requiring numerical input, press this button to move to another digit. Page 314 Displaying the Paper Reference Guide iPF770 Select the Support sheet and click the User Man- ual button. Page 356 Updating Media Information After Installation iPF770 Select the folder that contains the media information file
(.amx file) you downloaded and click the OK button. Page 66 Resizing Originals by Entering a Scaling Value (Mac OS) iPF770 ¢ Page Setup might not be displayed in the menu de- pending on the OS you are using and the applica- Note tion software. Ink is now drawn into the Maintenance Cartridge. Displaying Job Properties or Period Properties
Displaying Job Properties or Period Properties You can display the Job properties dialog box or Period Properties dialog box to check detailed cost information and other items. 545 Cannot print over a Bonjour network ...................... 545 Cannot connect the printer to the network Cannot connect the printer to the network Cause... Page 399 iPF770
Control Panel Arrow buttons  button ¢ Press this button on the Tab Selection screen to move to another tab. User's Guide... Note Click Monochrome in the Color Mode list. Page 84 Choose Print in the application menu. Changing the Object Overlapping Order Changing the Object Overlapping Order You can change the object overlapping order.
Page 105 iPF770 Printing Multiple Pages Continuously (Mac OS) ¢ Page Setup might not be displayed in the menu de- pending on the OS you are using and the applica- Note tion software. Updating the Firmware To obtain the latest firmware, visit the Canon website. Page 91 iPF770 Printing Vertical or Horizontal Banners (Large-Format Printing;
Mac OS) Choose Print in the application menu. printed without borders on the left and right sides only. Specifying Printer-Related Information iPF770 Other Settings Other Settings Specifying Printer-Related Information ...................... 454 Configuring the Communication Mode Manually .........c........... Your cooperation in the correct disposal of this
product will contribute to the effective usage of natural resour- ces. Follow these steps to replace the used roll with a new roll of the same type and size. Multi-Page Printing(PowerPoint) iPF770 Select Roll Paper Width that is set in the printer. If you want to use this software, do not uninstall the virtual printer Canon imagePROGRAF PrintPlugln.
Important ¢ The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing image- PROGRAF Print Plug-In for Office. Page 41 iPF770 Printing Line Drawings and Text (Mac OS) ¢ Page Setup might not be displayed in the menu de- pending on the OS you are using and the applica- Note tion software. iPF770
Applying a Saved Media Information File on Another Computer Applying a Saved Media Information File on Another Computer Applying a Saved Media Information File on Another Computer You can import and use the media information file you saved from your computer on other printers and computer by using the following procedure. 487
Automatic Banding Adjustment ......................... Enter the hot folder name in Name. iPF770 Configuring the Communication Mode Manually Configuring the Communication Mode Manually Configuring the Communication Mode Manually This topic gives instructions for configuring the communication mode manually. Unit may be damaged. Press A or
V to select Ethernet Driver, and then press the OK button. iPF770 Checking Instructions During Printer Operations Checking Instructions During Printer Operations Checking Instructions During Printer Operations You can refer to instructions on the printer control panel when loading paper, replacing ink tanks, or performing oth- er operations. A
message will appear informing you that analysis is in progress. 340 Changing the Type of Paper .........ccc.cceveeennnne. Use the same host name and do- Activate when using the same DNS host and domain names main name as IPv4 as for IPv4. Note * Menu Bar This allows you to select menus required for operations. Page 423 iPF770 Menu Settings
Setting Item Description, Instructions Inter- TCP/IP IPv6 Specify the DNS server address. 16 Loading and Printing on Sheets ...........cccc.ceee.... 18 Specifying Paper in the Printer Driver (Windows) ................ Page 529 iPF770 Clearing Jammed Roll Paper ¢ Do not touch the Linear Scale (a) or Carriage Shaft (b). Page 408 Menu Operations iPF770 ¢ Press
A to access a higher menu in the menu list, and press ¥ to access a lower one. The Canon website can be accessed from the link in the in- stalled software. Page 380 When this button is clicked, the Edit Media Types dialog box is displayed, which allows you to add media information files released by Canon to the printer control panel and printer
driver. Page 395 iPF770 Applying a Saved Media Information File on Another Computer Install and run the Media Configuration Tool on the other computer. ¢ Printing over a TCP/IP network (when using IPv4) ¢« Compatible operating systems Windows XP ¢... iPF770 Switching Media Types Display Show/Hide The Confirm Update dialog box is
displayed. ¢ Tool Bar This allows you to select tool buttons required for major operations. * Note Click Set under Page Layout to display the Pages to Print dialog box. The hot folder you have created appears in the Hot Folder list in the Color imageRUNNER Enlarge- ment Copy dialog box. Click the Next button. ¢ You can use the View menu to show
or hide the tool and status bar. 534 Cannot load sheets ...........cccoeeevveneennn. Page 294 Color Adjustment iPF770 Select Color Adjustment. Printing Posters in Sections iPF770 Make your selection in the Print Quality list. Remove the scrap when it is pushed out onto the Platen. (See "Main Pane .") P.252 -... Multi-Page Printing(Word) iPF770 Multi-Page
Printing(Word) Multi-Page Printing(Word) Prints multiple pages as one page. Printer Driver Settings iPF770 Printer Driver Printer Driver Printer Driver Settings ..........ccccccceveeennn. If that is the case, modify the data again. Page 4 Cutting Roll Paper After Printing ..........c...ccounnee. 135 Cutting Roll Paper After Printing (Windows) ...................... Page 335
iPF770 Specifying the Cutting Method for Rolls Manual (when using media that cannot be cut with the Cutter Unit ) On the Tab Selection screen of the Control Panel, press « or p» to select the Paper tab ( ¢ If the Tab Selection screen is not displayed, press the Menu button. In this case, click Canon Glossy Photo Paper 170gsm. ¢ Important When the
Image Size is set to a value smaller than 100% * When a graph is selected e... iPF770 Ink tank is empty. Preferences Dialog Box Preferences Dialog Box This dialog box appears when you select Preferences from the imagePROGRAF Advanced Preview menu. 38 Printing Line Drawings and Text ........................ 38 Printing Line Drawings and Text
(WIindows) .....ccceveveennnnns 39 Printing Line Drawings and Text (Mac OS) ............c....... 40 Printing from AutoCAD .......cccovvvvenverinnnnnnn. With the imagePROGRAF Free Layout feature, you can arrange originals from various source applications on a single page before printing. (See "Turning the Printer On and Off.") P.15 -... Not Print Spaces at the Top/Bottom
iPF770 Not Print Spaces at the Top/Bottom Not Print Spaces at the Top/Bottom You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or bottom. Canon imagePROGRAF iPFxxxx Status Print Printer model Firm Firmware version... Page 315 iPF770 Displaying the Paper Reference Guide Select
the printer from the list of printers and click Op- tions & Supplies. (See "Cleaning the Printhead.") P.503 -... For Mac OS X, Safari 1.32 or later or 2.03 or later also is supported. iPF770 Printing With Watermarks Other useful settings Other useful settings Printing With Watermarks .............c............ 129 Printing with Watermarks—COPY, FILE COPY,
and so on (Windows) ............ 130 Making the Original Orientation Match the Paper Orientation ................ 131 Making the Original Orientation Match the Paper Orientation (Windows) ............ * Options displayed in the Print Quality list vary depending on the paper type. To start from Microsoft Word iPF770 Click About in the Help menu of application.
When this setting is on, printing is performed with the top, bottom, left, and right margins layed out equally. Confirming Interface Print information The following information is included in the Interface Print report. The default browser on your computer is started and the Canon website is displayed. Resizing Originals by Entering a Scaling Value
(Windows) iPF770 « For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an im- age-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more Note at actual size. Page 50 Fine-Tuning Colors of Photos and Images (Mac OS) iPF770 « Page Setup might not be
displayed in the menu de- pending on the OS you are using and the applica- Note tion software. If "Not finished printing. 140 Specifying Paper in the Printer Driver ...................... 142 Confirming Print Settings ..........ccoeevueeennene. 143 Checking the Layout in a Preview Before Printing .................. 143 Using Favorites ......c..ccocevvviiineinnnnnn. If you accept the
agreement, click Yes. ¢ To display the Color Adjustment pane, on the Main pane, click Color Settings in Advanced Settings. Choose Page Setup from the application menu to display the Page Attributes dialog box. Page 9 Print Job Management Status Monitor (Windows) The Features of imagePROGRAF Status Monitor .................... 462 Job
Management Using imagePROGRAF Status Monitor .................. 463 Printmonitor (Mac OS) The Features of imagePROGRAF Printmonitor ........c.............. Select the printer for which to configure the media informa- tion, and then click the Next button. The Folded Duplex window consists of the menu and tool bars, layout area and status bar. 526
Problems Regarding Paper ............... * You can change the numbers by clicking ¥ button. ¢ If you specify the same position for multiple items, the items are printed from left to right in this order: date, user name, and page number. Note From the list, select the printer and select the Layout sheet. Jobs sent from the computer are printed immediately.
Page 11 Cannot print over a Bonjour network ...........ccc.......... 545 Installation problems The computer does not recognize the printer ...................... 546 Removing Installed Printer Drivers ..........ccccceevvenneee. 548 HP-GL/2 jobs are printed in monochrome (or color) .................. Roll paper cannot be inserted into the Paper Feed Slot iPF770 Pull the Release
Lever forward. Select the paper width of the roll loaded in the printer for Roll Width. Printing Multiple Originals Next to Each Other (Windows) iPF770 * Free Layout (Mac OS) Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even multiple source applications—in a single-page layout. 144
Accessing the Printer Driver Dialog Box from Applications ................ iPF770 Specifying the Cutting Method for Rolls In the Paper Detailed Settings dialog box displayed next, select the desired settings values in tween Pages and Between Scans in Drying Time, and then click OK. type or width of paper that is not Press A... Page 587 @uoikwv mépwv.
Print Status Print Print information about the setting values and condition of the printer. 312 Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings ........ 312 Displaying the Paper Reference Guide ........................ Enables color matching using ICC profiles. Note Laying out a Multiple-File Document on One Page
Laying out a Multiple-File Document on One Page You can lay out and print a multiple-file document on one page. For details on settings items, refer to the printer driver help. iPF770 Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) ¢ Conserving Roll Paper by Printing Originals Without Top and Bottom
Margins (Mac OS) P.126 - Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based on the following example. ¢ For
tips on confirming print settings, see "Confirming Print Settings ." P.143 - Note Resizing Originals to Fit the Roll Width Resizing Originals to Fit the Roll Width You can freely adjust the size of originals by enlarging or reducing them as desired. Make your selection in the Print Target list. You can rotate, enlarge, or reduce an object. Page 451 -
(hyphens), and . Execute printhead cleaning. Print Quality (*1) Description Print Priority Highest A setting for printing at the highest resolution Image when quality is most important. Pasting a Copied or Cut Object iPF770 * Send Backward Moves the object one position to the back. « Mac OS The basic instructions for accessing the Canon website
from imagePROGRAF Printmonitor are as follows. Attaching the Roll Holder to Rolls iPF770 Handling rolls Handling rolls Attaching the Roll Holder to Rolls ...........cc.ceeeueee. 320 Loading Rolls in the Printer ...........cccoeevueneeee. 322 Changing the Type of Paper ........cccceeevvevvennnnes * You can select only after ColorSync has been selected in Matching Mode. Click
Set to display the Color Settings dialog box. Start Microsoft PowerPoint. Page 219 iPF770 Print Matching Roll Width(Word) Click Print Matching Roll Width. Never touch the nozzles (b) or metal con- tacts (c). When the results of the printout are brighter than the original images such as the original photo before scanning and graphics cre- ated on the
display, or when you want to print in different degrees of brightness, use this feature. iPF770 Adjusting Line Misalignment Examine adjustment test pattern D-1 and determine the num- ber with straight lines. Lift the Support Rod to the position shown (a) and switch the stacker to Extended position A. Viac informdcii ndjdete aj na webovej stranke:
www.canon-europe.com/weee , alebo www.canon-europe.com/battery ... Press A or ¥ to select Chg. Click Free Layout in the Page Layout list. ¢ If only one cell is selected, Print Selected Area cannot be selected. For details on settings items, refer to the printer driv- er help file. On the Tab Selection screen of the Control Panel, press « or » to select
the Paper tab ( ¢... 439 Network Setting Print Job Management Adjustments for Better Print Quality Maintenance and Consumables Troubleshooting Error Message... Note On the Output Settings Panel , click the Print P.272... In the FineZoom Settings list, click Yes. Even when you are away from the printer, you can know when printing is finished or
if errors occur. Select Roll Paper Width that is set in the printer. For details on how to use the Extended position which is a useful function for retrieving prin- ted matter, refer to the note regarding the Extended position. Page 138 Cutting Roll Paper After Printing (Mac OS) iPF770 Access the Main pane. using a driver specific color profile. Adjusting
the Color in the Printer Driver iPF770 Adjusting Images Adjusting Images Adjusting the Color in the Printer Driver ...................... 46 Fine-Tuning Colors of Photos and Images (Windows) .................. Page size: 10x12 inches (254.0x304.8 mm) ¢ ¢ Paper: Roll * Paper type: Canon Glossy Photo Paper 170gsm ¢ Roll paper width: 10 inches (254.0 mm) In
the application, create an original that takes up the entire space of the paper size. (periods). The Power Lamp is lit when the printer finishes starting up, and the printer is now in Standby. Page 334 Specifying the Cutting Method for Rolls iPF770 Eject (waiting for ink to dry after printing) * When cutting wide printed documents after ejection, have
two people support the documents. Disassemble and repackage the Stand by following the installation procedure in reverse. On the Support sheet, you can view support information and the user's manual. The print jobs of other users cannot be controlled. Remove the jam- med paper as follows. Detailed Settings iPF770 ¢ Layout Area This allows you
to lay out objects and edit the object size and orientation. 442 Using RemoteUI ................ 444 Initial Settings .................. 446 Mac OS Settings ................ 453 Other Settings .................. iPF770 Conserving Roll Paper by Rotating Originals 90 Degrees Conserving roll paper Conserving roll paper Conserving Roll Paper by Rotating Originals 90 Degrees
................ 121 Conserving Roll Paper by Rotating Originals 90 Degrees (Windows) ............121 Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS) ............122 Conserving Roll Paper by Printing Originals Without Top and Bottom Margins .......... Finished Size Settings Dialog Box iPF770 * Layout Area This allows you to check the
arrangement and orientation of objects. Paper Settings Button Printing Wizard dialog box ¢ If you want to change the display to another file or application while the Printing Wizard is open, close the Printing Wizard dialog box. * Cut the edge of the roll after the paper is advanced if it is soiled or if there are cuts from scissors or the blade after
removing creased edges. iPF770 User's Guide Basic Printing Workflow Enhanced Printing Options Choosing Paper for Printing .............. 28 Printing Photos and Office Documents .......... 29 Printing CAD Drawings ................ Setup( *7 ) er( *7 ) TCP/IP( *7 ) Page 414 Menu Structure iPF770 First Level Second Level Third Level Fourth Level Fifth Level
Sixth Level Seventh Level Eighth Level Shut Down Off | 5 min. 536 Ink Filling.. Cause Corrective Action The Printhead nozzles are... Hold the used Maintenance Cartridge by the grip (a) with one hand and put your other hand under the Maintenance Cartridge to hold it firmly on the bottom, keeping it level as you pull it out. * Unless otherwise noted,
the job operation buttons only affect your own print jobs. Internet is required in order to download the Media Information File. Economy Printing When this mode is selected, less ink is consumed than in regular printing, but the quality is diminished. iPF770 Free Layout Main Window Free Layout Main Window Free Layout Main Window The Free
Layout main window consists of the menu and tool bars, layout area and status bar. Load a single sheet printing-side up in the Paper Feed Slot, with the right edge aligned with the Paper Alignment Guide (a) to the right of the Roll Cover. 446 Configuring the IP Address Using ARP and PING Commands .............. iPF770 Paper Settings Panel Paper
Settings Panel Paper Settings Panel This panel appears when you select Paper Settings in the dialog area. Lower the Support Rod to the position shown (a) to return to the regular position. 532 Roll paper cannot be inserted into the Paper Feed Slot .................. Page 215 iPF770 When Print Plug-In for Office is not displayed ¢ For Microsoft Office 2007
Click the Office button and then click the options button. Unidirectional Printing Prints by suppressing color variations and misaligned ruled lines. 569 Maintenance cartridge full. If this message is displayed, press the OK button and contact your Canon dealer for assistance. The printer is compatible with Hi-Speed USB connections. ¢ Giving Priority
to Particular Graphic Elements and Colors for Printing P.52 - ¢ Print Quality Choose the level of print quality. 132 Making the Original Orientation Match the Paper Orientation (Mac OS) ............ Check the firmware version. If Addin imageprograf print plug-in (ipfaddinif.dll) is dis- played in the Disabled Items dialog box, select it and click the Enable
button. iPF770 Specifying Paper in the Printer Driver ¢« Page Setup Pane P.263 - You can specify the page size of the original, borderless printing, enlargement or reduction, the orientation, the paper size and source, and automatic cutting. Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Page 393 iPF770
Changing the Display Order of Media Types Click the Add Genuine Paper button in the Media Configuration Tool main window. ¢ If paper is jammed inside the Top Cover Open the Top Cover and move the Carriage to the left or right side manually, away from the jam. *Although Scaling can be set to make the image larger than the media size, the part
that does not fit in the media cannot be printed. Important Pull the Printhead Fixer Lever forward all the way to open it completely. Page 376 Updating Media Information After Installation iPF770 The Add Media Type dialog box is displayed. ¢ If PageComposer is running, access the Special Settings dialog box from the Layout sheet and clear Preview
Switching. Switching Media Types Display Show/Hide iPF770 In the Edit Media Types dialog box, click the Update button. If a mes- sage is displayed indicating to check the remaining capacity of the Maintenance Cartridge, or before tasks that de- plete much of the capacity such as head cleaning or preparations to move the printer, check the
remaining Mainte- nance Cartridge capacity and prepare a new Maintenance Cartridge as needed. Select Actual Size from the tool bar. Alternatively, you may click on the Rotate check box in the Format Dialog Box then select Rotate P.185 - Right or Rotate Left, and click the OK button. Page 443 iPF770 Network Environment ¢ Example of a
Windows network In Windows networks, print over TCP/IP. Page 156 Matching Sheet iPF770 Driver Matching Mode The following options are available when you select Driver Matching Mode in the Matching Mode list. Page 332 Specifying the Ink Drying Time for Rolls iPF770 Select the Main sheet and click Advanced Set- tings in Media Type. Note
Zoom Dialog Box Zoom Dialog Box... Page 520 Preparing to Transfer the Printer iPF770 Repeat steps 2 and 3 to remove all ink tanks. iPF770 User's Guide Basic Printing Workflow Printing procedure ................ 14 Canceling print jobs ................ 22 Pausing Printing .................. Note Click Color (CAD) in the Color Mode list. Configuring the Printer's
TCP/IP Network Settings With RemoteUI iPF770 ¢ If you switch to printing in a Bonjour network, see "Configuring the Destination for Bonjour Network ." P.453 - Configuring the Printer's TCP/IP Network Settings With RemoteUI Configuring the Printer's TCP/IP Network Settings With RemoteUI Follow the steps below to configure the TCP/IP
network settings. Page 204 Creating a New Hot Folder iPF770 The Easy Setup Wizard dialog box displays. iPF770 Removing the Roll Holder from Rolls ¢ To load new roll paper in the printer at this point, see "Loading Rolls in the Printer." P.322 - Note Removing the Roll Holder from Rolls Removing the Roll Holder from Rolls Lift the Holder Stopper
lever (a) from the shaft side to unlock it. « Microsoft is a registered trademark of Microsoft Corporation. Dialog Box for the Printing Application In the View set. iPF770 Advanced Settings * The number of settings available for selection depends on the media type. This type of paper is not compatible with HP-GL/2. Select the Print Centered check box.
Page 57 iPF770 Choosing the Document Type and Printing Conditions (Mac OS) Click Advanced Settings to switch the print mode. Printing in Windows iPF770 Load the sheet. ¢ Display Series You can limit the number of options shown in Page Size, Paper Size, and Paper Size List. Email Notification When Printing is Finished or Errors Occur iPF770
Email Notification When Printing is Finished or Errors Occur Email Notification When Printing is Finished or Errors Occur The printer can notify you of the printer status by email. Or, open the Accounting sheet and click the Ac- counting button. Color (CAD) 4 Print emulating the HP Designjet 500/800, in colors re- sembling colors produced by these
printers. We recommend that you select an ICC profile created using commercially available profile creation software in order to perform color management accurately on paper other than genuine Canon paper and feed confirmed paper. 466 -... iPF770 User's Guide Basic Printing Workflow Enhanced Printing Options Windows Software Mac OS

Software Handling and Use of Paper Control Panel Printer Parts Network Setting Network Environment ................ Page 581 See for detail. Printing Multiple Pages Per Sheet iPF770 Access the Page Setup pane. iPF770 Making the Original Orientation Match the Paper Orientation Select and click a roll paper in the Paper Source list. iPF770 Accessing
the Printer Driver Dialog Box from the Operating System Menu Six sheets of print settings are displayed by the print- er driver: Main, Page Setup, Layout, Favorites, Utility, and Support. Page 150 Main Sheet iPF770 Configuration using Easy Settings ¢ Print Target Choose presets that match the type of document to be printed. Click OK, and return to
the Print screen. The Data lamp on the Control Panel does not light up iPF770 Printing does not start Printing does not start The Data lamp on the Control Panel does not light up .................. 536 The printer does not respond even if print jobs are sent .................. For details on available printing conditions, see "Printer Driver Settings ." P.248 ...

Alternatively, you may select Copy or Cut from the Edit menu. ¢ Paper Size Options Dialog Box P.161 ... iPF770 The length of printed images is inaccurate in the feeding direction The length of printed images is inaccurate in the feeding direction The length of printed images is inaccurate in the feeding direction Cause Corrective Action In the
Control Panel menu, Adj. Important Click the Add Genuine Paper button in the Media Configuration Tool main window. Printing Originals Centered on Sheets (Mac OS) iPF770 Click the Page Setup tab to display the Page Setup sheet. Click on the Enl./Red. After the roll paper is cut, it is rewound automatically. * When you update the media

information, the paper display order and Show/Hide settings return to their default values. iPF770 Job List Area * Status Bar Displays messages and other information. P.146 - Make sure the Main sheet is displayed. Paper mismatch iPF770 Messages regarding paper Messages regarding paper Paper mismatch ..........c...cc..coeeeuneee. (See "Loading Sheets
in the Print- er.") P.340 - The printer now starts printing the print job. Smooth gradation is a feature. Touching these parts may damage them. Ink lamps flash when there is little ink left. iPF770 imagePROGRAF Device Setup Utility Device Setup Utility (Windows) Device Setup Utility (Windows) imagePROGRAF Device Setup Utility ...........ccun...... 457
Installing imagePROGRAF Device Setup Utility .......cccceceennees 457 Configuring the IP Address Using imagePROGRAF Device Setup Utility ............ 457 imagePROGRAF Device Setup Utility imagePROGRAF Device Setup Utility imagePROGRAF Device Setup Utility is a utility to establish communication between the printer and your com- puter by

completing relevant settings. Using PosterArtist to Compose Originals iPF770 Access the Page Setup pane. 503 Cleaning the Printer Exterior Cleaning the Printer Exterior Clean the printer regularly to maintain better printing quality and help prevent problems. Page 388 Changing Media Names iPF770 ¢ To restore the original names, click the
Restore button. The Confirm Update dialog box is displayed. Button Click the button to acquire printer information. For details, refer to the Mac OS documentation. The printer is damaged. Page 370 Changing the Display Order of Media Types iPF770 Select the paper in the Media Type list for which to change the display order, and then click the
buttons to move the item ( The selected item moves one line up or down for ev- ery button click. Page 347 iPF770 Using the Output Stacker Extended position A Extended position B * Switching to Extended position A Switch the stacker to Extended position A as follows. On the Paper Settings Panel , select Roll Paper in Paper Source. Close tank
COVET....cccvnevnnnnnn. 564 Cannot detect papr .......coceeeeeveeeennennnn. 562 Cannot recognize print head........................... Select the No Spaces at Top or Bottom (Conserve Paper) check box. Clearing Jammed Paper (Paper Feed Slot) iPF770 ¢ If the paper is jammed by the Ejection Guide Remove the jammed paper from the Output Tray. Printing in Windows
Printing in Windows Print from the application menu. Carrying Handles When carrying the printer, have three people hold it by these handles on the back at both ends. Adjustment cannot be comple- ted correctly unless the loaded paper matches the settings. Page 515 iPF770 Cleaning Inside the Top Cover ¢ If the Platen inside the Top Cover
becomes dirty, it may soil the underside of paper. (See "Checking for Nozzle Clogging.") P.502 - Application Color Matching Priority is set to Off Click Special Settings in the Layout sheet of the printer driver, and set Ap- in the Windows printer driver. Output Stacker Printed documents are ejected into the output tray. ¢ If data analysis requires time,
a message dialog will appear. * Follow the steps below to print only a portion of the poster as divided for printing. Note ¢ Soft Proof When you place a checkmark here, ColorSync applies to the layout area. Note Click the imagePROGRAF Print Plug-In button. Priority is Set Adj. Please wait." is displayed. You should nor- Driver Matching Mode P.278 >
mally select this mode. Page 586 152/06. Caution * When assembling the Stand, lock all four of the casters. Page 111 iPF770 Printing Large Posters (Windows) Choose Print in the application menu. Menu Limited items are displayed during printing. Choose the mode that suits your particular printing application. Page 583 iPF770 About This User
Manual ¢ Cross-reference Other pages or manuals that provide related information are indicated as follows in this user manual. Wait a few moments and then select Refresh in the View menu to display the print jobs. Click the Print button. iPF770 Control Panel Display Printer status and modes The printer has the following status. Remove the Ink
Tank Open the Ink Tank Cover. (See "Paper Sizes.") (See "Displaying the Paper Reference Guide.") P.310 P.313 - - Note * To view instructions as you attach the Roll Holder, press the Navigate button. Accounting Manager Basic Procedures iPF770 « Owner The sender of the job. Pull the Release Lever forward. iPF770 Insufficient paper for job Cause
Corrective Action Paper has been loaded Load the sheet, aligning it with the guide on the right. However, the Device Settings sheet is for configuring the printer, and it is an extension of the printer driver. Click High (1200dpi) in the Print Quality list. The method of removing printer drivers varies depending on the version of Windows. alphanumeric,
space, "-", "t ()Y, 4, "%, L, " el o To display the Paper Detailed Settings dialog box, on the Main pane, click Set by Media Type. 15 Loading and Printing on Rolls .............ccccccceeee. Page 383 iPF770 Adding Media Types Make sure that Connect to the Internet to get the latest information is selected, and then click the OK button. Roll
(254.0mm). Page 241 iPF770 Print Entire Sheet(Excel) The Layout menu will appear automatically. iPF770 Paper Size Options Dialog Box ¢ Size Options Click to display the Paper Size Options dialog box, which enables you to register additional paper sizes or select the size system for use. ¢ Your printer is depicted in the lower-left area of this screen.
Contact your Canon dealer or Warning support center. Color (CAD) 2 Print with approximate colors emulating Canon iPF750, iPF755, iPF650, iPF655, iPF760, iPF765. Page 180 Starting Free Layout iPF770 From the application software's File menu, select the printer setup menu to open the Print dialog box. Note ¢ Soft Proof When you place a
checkmark here, ColorSync applies to the preview area. You can configure the printing settings to match the type of media, such as the ink drying time. In the Device Name list displayed, select the printer to configure. Using Paper Other Than Genuine Paper and feed confirmed Paper Using Paper Other Than Genuine Paper and feed confirmed Paper
When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use paper that meets the following conditions. * When setting a data to the printer that differs from the data to be updated, the selected media informa- tion file is updated. iPF770 ICC Matching Mode ICC Matching Mode ICC Matching Mode Under
Matching Mode, select ICC Matching Mode. Priority setting for rotating 90 degrees iPF770 ¢ Changing the ruler unit You can set the ruler unit when you select Units from the View menu. 265 Preview Main Window .............cccccevunneeen. This option reduces the amount of deb- here.)( *1 ) ris given off after cutting. Page 445 iPF770 Using RemoteUI ¢ For
the Web browser, use Netscape Navigator 6.0 or later, Internet Explorer 5.01 or later, or Firefox 1.5 or later. * The genuine Canon paper settings provided in the printer control panel and printer driver are optimized for genu- ine Canon paper. iPF770 Status Print Setting Item Description, Instructions Admin. Accessing the Printer Driver Dialog Box
from Applications iPF770 Click the Favorites tab to display the Favorites sheet. For color matching based on ICC profiles, select ICC Matching Mode depending on your color matching system. Canceling Print Jobs from the Control Panel iPF770 Canceling print jobs Canceling print jobs Canceling Print Jobs from the Control Panel .................... 22
Canceling Print Jobs from Windows ......................... Close the Ink Tank Cover. Page 531 iPF770 Clearing a Jammed Sheet ¢ Do not move the Carriage over jammed paper. * When new paper supported by the printer is added, the media information file can be automatically downloa- ded from the Canon website and the new media information can be
added to the printer control panel and printer driver. iPF770 Object Adjustment Dialog box: Color ¢ Defaults Click to restore all settings on the sheet to the default values. The scroll bar at right indicates the current position in the overall menu. Page 343 iPF770 Printing From a Desired Starting Point Open the Top Cover and check the position where
paper is loaded. for the first character, or - or . Page 440 iPF770 User's Guide... ¢ Printing Multiple Pages Per Sheet (Windows) P.107 - « Printing Multiple Pages Per Sheet (Mac OS) P.108 -... Accessing the Printer Driver Dialog Box from Applications iPF770 ¢ In the printing dialog box, click Save As in the Presets list to save the current print
settings. 25 Enhanced Printing Options Windows Software Mac OS Software Handling and Use of Paper Control Panel Printer Parts Network Setting Print Job Management Adjustments for Better Print Quality Maintenance and Consumables Troubleshooting... Page 59 iPF770 Resizing Originals to Match the Paper Size (Windows) ¢ Roll paper width:
A2/A3 roll (420.0 mm [16.5 in]) Choose Print in the application menu. iPF770 ColorSync ColorSync ColorSync Check that ColorSync is selected in Matching Mode. Adding Media Types Adding Media Types You can register media information files (.amx file) released by Canon in the printer control panel and printer driver. iPF770 Cannot adjust
printhead. Choosing the Document Type and Printing Conditions (Mac OS) iPF770 Choosing the Document Type and Printing Conditions (Mac OS) Choosing the Document Type and Printing Conditions (Mac OS) You can specify your own print settings instead of using the Print Target presets. Canon Inc. Per ulteriori informazioni sul riciclaggio di
questo prodotto, contattare le autorita locali, 'ente responsabile della rac- colta dei rifiuti, un rivenditore autorizzato o il servizio di raccolta dei rifiuti domestici, oppure visitare il sito www.canon-europe.com/weee www.canon-europe.com/battery -... 564 Remaining level of the ink cannot be correctly detected. Page 51 iPF770 Fine-Tuning Colors of
Photos and Images (Mac OS) Click Advanced Settings to switch the print mode. Preview Main Window iPF770 Click the Print button in the Print dialog box. In the Media Type, choose the type of paper used for printing, such as Glossy Paper, Canon Coated Paper, and so on. Checking the information in Status Print reports The following information is
included in Status Print reports. Format Dialog Box iPF770 ¢ Rotate When you place a checkmark here, you can select Rotate Right or Rotate Left. iPF770 Fine-Tuning Colors of Photos and Images (Windows) ¢ If No color correction is selected under Color Mode, the Matching cannot be changed. The printer will resume printing. iPF770 Matching °
Matching Mode You can select a matching mode to suit the print job. For instructions on arranging originals from multiple applications, refer to the following topics. When you attempt to print, the imagePROGRAF Free Layout window is displayed. Use this dialog box to configure the display settings. iPF770 User's Guide Basic Printing Workflow
Enhanced Printing Options Windows Software Mac OS Software Handling and Use of Paper Control Panel Printer Parts Network Setting Print Job Management Adjustments for Better Print Quality Maintenance and Consumables Troubleshooting Frequently Asked Questions ............. Page 112 Printing Large Posters (Windows) iPF770 Select the Page
Layout check box. Name Contents Medium Setup Guide... Sleep mode 5 W max. Note * Print Quality Selecting print quality strikes a balance between the quality of the printed image and printing speed. Page 67 iPF770 Resizing Originals by Entering a Scaling Value (Mac OS) Access the Page Setup pane. Click High (600dpi) in the Print Quality list.
How to view instructions Once you complete an action described in the instructions, the printer detects the action and switches to the next instruction screen. Select the width of the loaded roll in the Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm). Menu is displayed. Messages regarding printheads Messages regarding printheads
Cannot adjust printhead.............ccceeeveennes 567 Wrong printhead............cccoevvvvnnnnnnn. Preview main window is displayed. cludes HP RTL commands when Auto Ro- (See "Menu Settings.") P.416 - tate is On in the Control Panel menu. Priority is Automatic or Print Length. Use the following procedure to open Media Configuration Tool main window. Cause
Corrective Action The roll is empty. iPF770 Menu Operations Fine-tuning paper feeding Display of printer-related information For a description of specific menu items available, see "Menu Settings." P.416 - For instructions on selecting menu items during printing, see "Menu Operations." P.407 - Menu Operations Menu Operations To view available
menus organized on tabs, select a tab on the Tab Selection screen and press the OK button. Press A or ¥ to select On, and then press the OK button. Click the buttons on the toolbar/ribbon according to the items you want to set. 327 Removing the Roll Holder from Rolls ....................... Select the media type by following the descrip- tion below. 557 The
roll is empty....ccovevvvveiiinreinnnnnn. 47 Fine-Tuning Colors of Photos and Images (Mac OS) .................. 49 Giving Priority to Particular Graphic Elements and Colors for Printing ............... Page 506 Replacing the Printhead iPF770 ¢ Do not touch the Linear Scale (a) or Carriage Shaft (b). Press A or ¥ to select Interface Print, and then press the OK button.
Click Paper Reference Guide. Click the About button in the Media Configuration Tool main window to open the About dialog box. Page 368 Switching Media Types Display Show/Hide iPF770 The Edit Media Types dialog box is displayed. Page 205 iPF770 Creating a New Hot Folder Select roll paper or cut sheet to print. iPF770 Depression on the
leading edge is left Depression on the leading edge is left Depression on the leading edge is left Cause Corrective Action Keeping a roll in the printer for a long time When printing quality is most important, we recommend setting TrimEdge Reload to without printing on it may leave a depres- On or Automatic so that the paper edge is automatically cut
before printing. Click Roll Paper (Banner) in the Paper Source list. After removing the paper, make sure there are no oth- er scraps of paper in the printer. « Media Type This allows you to select the media type. In this case, 10 in. Making the Original Orientation Match the Paper Orientation (Windows) iPF770 Making the Original Orientation Match
the Paper Orientation (Windows) Making the Original Orientation Match the Paper Orientation (Windows) This topic describes how to print an original in landscape orientation after matching the paper orientation, based on the following example. Page 426 Press A or V¥ to select Status Print, and then press the OK button. Page 508 Replacing the
Printhead iPF770 Pull the Printhead Fixer Cover down toward the front to lock the Printhead in place. 436 Ink Tank Cover (Inside) ..........c.cccoeevunennnnnn. This may stain your hands and damage the print- Important ¢ If paper from a roll is jammed by the Paper Feed Slot Remove the jammed paper from the Paper Feed Slot. Output Settings Panel iPF770 -
The number of settings available for selection depends on the media type. Use the correct attachment for the particular paper core. Brightness Adjusts the brightness of the entire image. iPF770 Enlarge/Reduce the screen display * No Spaces at Top or Bottom You can save paper on not to feed roll paper for the empty spaces when the print data
contains spaces at the top or bottom. You can print handouts into a single page, or print matter with many pages. Page 188 Laying out a Multiple-File Document on One Page iPF770 In the Layout sheet, click on the Page Layout check box and select Free Layout from the list. The License Agreement is displayed. iPF770 Paper jam Paper jam Paper jam
Cause Corrective Action A paper jam oc- For roll paper, cut the paper on the upper side of the {Paper Feed Slot. Open the Ink Tank Cover, and replace the Ink Tank for the There are no ink colors with x displayed above the remaining ink indi- color that is out of ink. Color (CAD) 3 Print emulating the following printers, in colors resembling colors
produced by these printers: Canon iPF500, iPF600, iPF700, iPF510, iPF610, iPF710, iPF605, iPF720, iPF810, iPF820, iPF815 and iPF825. Setting Details Brightness Adjusts the brightness of the entire image. * To select an object, click that object. Enter a desired name in Name, such as Photos for Presentations or Monthly Report. Cleaning the
Printer Exterior iPF770 Cleaning the Printer Cleaning the Printer Cleaning the Printer Exterior ..........c......cc..c..... Page 171 iPF770 Preview Main Window ¢ Preview Area You can check the settings you made in this area. Using RemoteUI iPF770 Using RemoteUI Using RemoteUI Using RemoteUI Using RemoteUI RemoteUl is software with which you
can access the printer via the network from your Web browser to confirm the printer status, operate jobs, and configure the settings. 437 Stand ............c.ccoeevennnenn. 438 Control Panel ...........cccccevveeennnnnnn. 398 Front Front Roll Cover Open this cover to load rolls. Fold an A4 sheet lengthwise four times and insert it through the gap of the Paper Feed Slot.
* Printing is done in Print Matching Roll Width of the Printing Wizard. Remove the Printhead and press the OK button. Checking the update iPF770 Configure Update Target and click the Execute but- ton. Page 366 Deleting Media Types You Have Added iPF770 Click the Add Genuine Paper button in the Media Configuration Tool main window. 325
Specifying the Paper Length ......c...ccoeeeeinn. Color Settings Panel iPF770 Color Settings Panel Color Settings Panel This panel appears when you select Color Settings in the dialog area. Press A or ¥ to select Test Print, and then press the OK button. iPF770 User's Guide Basic Printing Workflow Enhanced Printing Options Windows Software Mac OS
Software Handling and Use of Paper Control Panel Printer Parts Network Setting Print Job Management Adjustments for Better Print Quality Maintenance and Consumables Troubleshooting Error Message Error Messages ................. Page 233 iPF770 Multi-Page Printing(PowerPoint) Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
This lists the unit costs for items such as the selected ink and paper. Borderless Printing(Word) iPF770 Borderless Printing(Word) Borderless Printing(Word) Prints up to the border of the media. In the Paper Detailed Settings dialog box displayed next, select the desired settings values in tween Pages and Between Scans in Drying Time, and then click
OK. Page 516 Cleaning Inside the Top Cover iPF770 Using a damp cloth that you have wrung out completely, wipe inside the Top Cover to clean it. Cross-reference in the same user manual Example: see "Menu Structure." P.410 - Click the link to jump to the corresponding page. 272 Color Settings Panel .............c.............. Enter name in Name. Note
Go to Page Dialog Box Go to Page Dialog Box This dialog box appears when you select Go to Page from the View menu. iPF770 Fine-Tuning Colors of Photos and Images (Mac OS) Adjustment Item Description Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow. If the firmware available online is newer than the installed
firmware, update the printer firmware. 567 Cannot recognize print head...........c....cc......... « This is not displayed when a checkmark is placed in Borderless Printing. Page 82 P.146 » Make sure the Main sheet is displayed. ¢ If the Borderless Printing checkbox is checked, only media types that can be used for borderless print- ing are displayed in the
list. It cannot be used when printing on sheets. Specifying an Existing Shared Folder as a Hot Folder Specifying an Existing Shared Folder as a Hot Folder Share the folder you want to specify as a hot folder. (See "Changing the Type of Pa- per.") P.325 & ¢ If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify
the roll length after the type of paper. Click Roll Paper Options to display the Roll Paper Op- tions dialog box. If Start imagePROGRAF Print Plug-In is displayed, click it. iPF770 Menu Settings Set./Adj. Page 10 Maintenance Cartridge Maintenance Cartridge .............cccccevvvunnnen. 509 Replacing the Maintenance Cartridge ..........ccccecevun..e. 509 Checking the
Remaining Maintenance Cartridge Capacity .................. 512 When to Replace the Maintenance Cartridge ............cc........ 513 Cleaning the Printer Cleaning the Printer Exterior ............c..ccceceun..... Page 285 iPF770 Moving a Page The target page appears. These estimates will also vary depending on the conditions of print- er use. * Near End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed. Choosing the Document Type and Printing Conditions (Windows) iPF770 Setting Item Description Reduce Print Unevenness (*1) Choose this option to counteract uneven printing. * Status Bar This shows the paper size, unit of length, and number of objects.
The location of the folders will appear. Print Using Registered Settings(Word) iPF770 Click the One-Touch Registration button. Page 95 iPF770 Printing on Non-Standard Paper Sizes (Windows) Confirm the print settings and print as desired. iPF770 Ink Tank Cover (Inside) Printhead Fixer Lever Locks the Printhead Fixer Cover. Click Color in the
Color Mode list. After removing the paper, make sure there are no other scraps of paper in the printer. Select the media type to print. Page 519 If consumables must be replaced, the message "Consumables must be replaced. Page 341 iPF770 Loading Sheets in the Printer Slide the Width Guide (a) to align it with the mark for the size of paper you will
load. Moving an Object iPF770 Resizing by means of mouse operation Select an object. The setting of Custom Size is disabled when you exit the application software. With HP-GL/2, printing is misaligned iPF770 HP-GL/2 problems HP-GL/2 problems With HP-GL/2, printing is misaligned ...................... 548 Lines or images are missing in printed HP-GL/2
jobs..ceiiiiiiiiis 548 Lines are printed too thick or thin in HP-GL/2 print jobs .................. Printing on the center begins. Page 415 iPF770 Menu Structure *2: Available if Adj. Page 328 Removing the Roll from the Printer iPF770 Positioning your hands as shown, open the Roll Cover. Each of the four tabs presents status, menus, and error information
related to the particular tab. For information about instsalling, see "Steps to install." P.210 = Enabling Print Plug-In for Office for items disabled in Office applications If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application disables add-ins as a safety precaution. Test pattern B is printed for
adjustment. « When Head Height is set to Automatic, the setting value selec- ted for the previous print job is displayed (to the right of Auto- Note matic ) once you select the type of paper currently supplied. (See "Displaying the Paper Reference Guide.") Page 576 Print Area iPF770 ¢ Printable Area: The area that can be printed. 248 Specifying Paper
in the Printer Driver .............c........ 249 Confirming Print Settings .........cccoevvveineanis 250 Checking the Layout in a Preview Before Printing .................. 251 Using Favorites .......ccoeevvevnveinnennnnn. Applying a Saved Media Information File on Another Computer iPF770 In the Edit Media Types dialog box, click the Update button. | 30 sec. 173 Moving a Page
............................... Remove the jammed paper. Display with Actual Size iPF770 All is displayed. Caution ¢ Do not release the flanges until the holder is loaded in the Roll Holder Slot. If paper is not stored properly, the printing surface may become scratched, which may affect the printing quality when you use it Important again. iPF770 Top Cover
(Inside) Top Cover (Inside) Top Cover (Inside) Carriage Moves the Printhead. Cause... Load the paper. ¢ If you printed test pattern A on a sheet, follow the instructions on the Display Screen and use another sheet of the same type of paper. iPF770 Print Matching Roll Width(PowerPoint) Print Matching Roll Width(PowerPoint) Print Matching Roll
Width(PowerPoint) Prints to the edge of the roll width. Device Settings Sheet iPF770 Device Settings Sheet Device Settings Sheet Many settings items on the printer properties sheets are controlled by Windows applications. Printing Multiple Pages Continuously (Mac OS) iPF770 Click the Page Setup tab to display the Page Setup sheet. Special
Settings Dialog Box iPF770 ¢ Format Settings Click to display the Format Settings dialog box, which enables you to complete format-related settings. Adjustment Item Description Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow. If you choose On, a line will be printed at the cut position when per is displayed paper cutting is
selected. iPF770 Paper rubs against the Printhead Paper rubs against the Printhead Paper rubs against the Printhead Cause Corrective Action The type of paper specified in the Load paper of the same type as you have specified in the printer driver. Important ¢... Press A or ¥ to select Yes, and then press the OK button. Plug the power cord into the
outlet. iPF770 User's Guide Basic Printing Workflow Enhanced Printing Options Windows Software Mac OS Software Handling and Use of Paper Control Panel Printer Parts Network Setting Print Job Management Status Monitor (Windows) .............. 462 Printmonitor (Mac OS) ...............  If you want to change the display to another file or application
while the Large-Format Printing Wizard is open, close the Large-Format Printing Wizard dialog box. iPF770 Messages regarding printing or adjustment Messages regarding printing or adjustment Cannot adjust printhead..............c........... 567 Borderless printng not possible........................ 563 Cannot adjust paper feed.........c...ccouuneen. 566 Check printed
document...........cceeevnneennn. 566 Cannot adjust paper feed. B:Standard/Draft ... Page 345 iPF770 Removing Sheets Pull the Release Lever forward. Utility Sheet iPF770 ¢ Click to display the Add dialog box, which enables you to add the current print settings as a favorite. iPF770 Zoom Dialog Box When you place a checkmark on Auto Settings, the one-
page length to be printed on roll paper is automati- cally set so that the laid-out objects are printed on one page. Select the printer in the Printer list. While continuing to hold the Output stacker handle (a), slowly lower the Output Stacker. Printing Vertical or Horizontal Banners (Large-Format Printing) iPF770 Printing banners or at other non-
standard sizes Printing banners or at other non-standard sizes Printing Vertical or Horizontal Banners (Large-Format Printing) ................. If these settings are selected for printing on paper other than genuine Canon paper, the ink may Important bleed or the printhead may rub against the paper. Specifications iPF770 Printer Specifications Printer
Specifications Specifications .............cccceeeveneenn. 574 Print Area .....ccocevvvevviveiinnnnnn, Setting Details Perceptual Color-matching optimized for printing typical photos attractively. Page 97 iPF770 Printing on Non-Standard Paper Sizes (Mac OS) In Paper Size, enter the height and width of the original. If the printing quality does not improve even after one
or two cycles of Head Cleaning B from the printer menu ¢ If the Display Screen indicates "Open top cover and replace the printhead." ¢ If your Canon dealer has advised you to replace the Printhead Compatible printheads For information on compatible printheads, see "Printhead." P.502 -... Setting Details Color Enables color printing. Select this
when color match- ing is performed by the application such as Adobe Photoshop or when you want to print color charts using the profile creation tool. In this case, click Canon Premium Glos- sy Paper 2 280. iPF770 Manual Adjustment to Straighten Lines and Colors Paper to Prepare When Using Rolls An unused roll at least 10 inches wide When
Using Sheets Auto(Standard) : One sheet of unused paper of at least A4/Letter size Auto(Advanced) : Five sheets of unused paper of at least A4/Letter size (or one sheet when using A2 or larger) Perform adjustment as follows. Show Job Log Print job settings. Page 243 iPF770 Print Selected Area(Excel) The Printing Wizard dialog box is displayed. 567
Check if ink tank is set, and its color and direction. We recommend cleaning the Platen after borderless printing or printing on small paper. Lift and press down the lever when replacing an Ink Tank. Alternatively, you may click on the Rotate check box in the Format Dialog Box then select Rotate P.302 - Right or Rotate Left, and click the OK button.
Printing CAD Drawings iPF770 Printing CAD Drawings Printing CAD Drawings Printing CAD Drawings ........ccccceeevvveeevnnnnns iPF770 Binding Settings Dialog Box Setting Details Specify Folded Size Prints by automatically enlarging or reducing the entire document to match the size of the paper. Settings Manag- Margin Specify the margin around paper.
iPF770 User's Guide Basic Printing Workflow Enhanced Printing Options Windows Software Mac OS Software Handling and Use of Paper Control Panel Printer Parts Network Setting Print Job Management Adjustments for Better Print Quality Maintenance and Consumables Troubleshooting Error Message Specifications Appendix Safety Precautions
................. iPF770 Printing Multiple Originals Next to Each Other (Mac OS) Click the Layout tab to display the Layout sheet. iPF770 Laying out a Document Created with Multiple Application Programs on One Page Laying out a Document Created with Multiple Application Programs on One Laying out a Document Created with Multiple Application
Programs on One Page Page You can lay out and print a document created with multiple application programs on one page. Platen The Printhead moves across the platen to print. In this case, you can skip the step Access the menu for ink tank replacement. (See "Borderless Printing at Actual Size.") P.72 - I want to know the paper Concerning the
paper that can be used in this printer, refer to the Canon website or the Paper Refer- types that can be used in ence Guide. Note Click the Page Setup tab to display the Page Setup sheet. 557 PaprWidth Mismatch .........c....ccceeeeeinii. 558 Paper size not detected...........c.coceeennenis 558 Insufficient paper for job ..........cccoeeeennnnenn. Press A or V¥ to select Stop
Printing, and then press the OK button. 503 Replacing the Printhead .......................... 504 Printhead Printhead When purchasing, check the Model number. Clearing a Jammed Sheet iPF770 Pull the Release Lever forward. Create Page Size in Portrait or Landscape Orientation. iPF770 Removing the Roll from the Printer Press the OK button. Prints
using Folded Duplex Prints using Folded Duplex This prints 2 pages consecutively. Otherwise, you may not be able to Important change displays or operate the toolbar/ribbon. * Always select media type that is actually set in the printer. Page 48 Fine-Tuning Colors of Photos and Images (Windows) iPF770 Select the printer in the dialog box, and then
display the printer driver dialog box. iPF770 Color Adjustment Setting Details No color correction Prints without performing color matching in the printer driver. 16 Loading and Printing on Sheets ............c............. 18 Printing in Windows ...........ccccevvveinneennnen. 20 Printing from Mac OS ..........cooevvviiiiiiinnennns If this setting does not match the loaded paper, it
may cause feed errors and affect printing quality. Page 517 iPF770 Cleaning Inside the Top Cover Close the Top Cover. Click the Page Setup tab to display the Page Setup sheet. The Set./Adj. Page 141 iPF770 Printer Driver Settings ¢ View Settings Dialog Box for the Printing Application P.153 - ¢ Color Adjustment Sheet: Color P.154 - ¢ Object
Adjustment Dialog box: Color P.155 - * Matching Sheet P.155 - « Color Adjustment Sheet: Monochrome P.157 -... You can also change names, toggle between displaying and hiding, and delete added media types. Print a test pattern to check the nozzles. iPF770 Clearing Jammed Roll Paper Problems Regarding Paper Problems Regarding Paper
Clearing Jammed Roll Paper ..........c...cevuneene... Roll Cover (Inside) iPF770 Roll Cover (Inside) Roll Cover (Inside) Roll Holder Load the roll on this holder. Access the Main pane. ¢ If two patterns seem equally good and you cannot decide which one is better, choose an intermediate value. | 10 min.* | 30 min. Free Layout main window is displayed. iPF770
Zoom Dialog Box * Margins You can input the paper margins in numerical characters. Select the actual size of the paper you want to print on in Fit Paper Size. Color Settings Pane: Monochrome iPF770 Color Settings Pane: Monochrome Color Settings Pane: Monochrome On the Color Adjustment pane for monochrome printing, you can adjust the
brightness and contrast. Page 505 iPF770 Replacing the Printhead On the Tab Selection screen of the Control Panel, press « or p to select the Settings/Adj. Page 412 Menu Structure iPF770 First Level Second Level Third Level Fourth Level Fifth Level Sixth Level Seventh Level Eighth Level Adj. Page 119 iPF770 Printing Originals Centered on
Sheets (Mac OS) ¢« Paper: Sheets Paper type: Plain Paper ¢ ¢ Paper size: Non-standard Choose Page Setup from the application menu to display the Page Attributes dialog box. Canon imagePROGRAF iPFxxxx Interface Print Printer model Firm Firmware Version... Run the Media Configuration Tool. Page 459 iPF770 Configuring the IP Address Using
imagePROGRAF Device Setup Utility When specifying an IPv6 IP address Start imagePROGRAF Device Setup Utility from the start menu. Cannot adjust paper feed. printer driver does not match the type (See "Loading Rolls in the Printer.") P.322... iPF770 Deleting Media Types You Have Added In the Edit Media Types dialog box, click the Update
button. In the Media Type list, select the type of paper that is loaded. You should nor- Driver Matching Mode P.297 - mally select this mode. iPF770 User's Guide Basic Printing Workflow Enhanced Printing Options Windows Software Mac OS Software Handling and Use of Paper Control Panel Printer Parts Network Setting Print Job Management
Adjustments for Better Print Quality Maintenance and Consumables Troubleshooting Error Message Specifications Printer Specifications ................. In Comment, enter a description of the favorite to be added, as desired. To reposition the paper, push the Release Lever back. ¢« For more information on the procedure for opening the Media
Configuration Tool main window, see "Media Configuration Tool Main Window." P.357 ... Easy Settings Easy Settings You can easily select the best settings for the print job by just selecting an item from the print target list that match- es the content of the document. iPF770 Laying out Objects Automatically Select Rotate Left or Rotate Right from
the toolbar. * When Print in Draft mode is selected, printing is fast but the print quality is poor. To receive a document scanned with the Color imageRUNNER, you need to share a folder. Setting Item Description, Instructions Test Nozzle Check Print a test pattern to check the nozzles. iPF770 Banding in different colors occurs Cause Corrective Action
The Printhead nozzles are clogged. Page 499 iPF770 Replacing Ink Tanks Installing Ink Tanks Before opening the pouch, gently agitate the Ink Tank once or twice. iPF770 Laying out Objects Automatically Select Rotate Left 90 Degrees orRotate Right 90 Degrees from the toolbar. Standby The printer is ready to receive jobs sent from the computer.
iPF770 Setting the Unit Cost for Ink ¢ Setting the Unit Cost for Paper P.472 - ¢ Setting the Unit Cost for Items Other Than Ink and Paper P.473 - Setting the Unit Cost for Ink Setting the Unit Cost for Ink Open the Ink sheet. 455 Email Notification When Printing is Finished or Errors Occur ................ 456 Initializing the Network Settings
........................ 456 Specifying Printer-Related Information Specifying Printer-Related Information Follow the steps below to specify device information and security settings. 569 Maint. Control Panel iPF770 Operations and Display Screen Operations and Display Screen Control Panel ..............................398 Control Panel Display ..........c..cccoeevvrnnenee.
Page 433 iPF770 Front Maintenance Cartridge Cover Open this cover to replace the Maintenance Cartridge. * Mac OS The basic instructions for displaying the Paper Reference Guide from the imagePROGRAF Printmonitor are as follows. The level of the print quality and resolution settings are displayed in the following combinations. Confirm the
print settings and print as desired. Checking the Remaining Maintenance Cartridge Capacity iPF770 Keeping the new Maintenance Cartridge level, insert it all the way in. 483 Troubleshooting Paper Abrasion and Blurry Images .................. 485 Adjusting the Printhead Adjusting the Printhead If printed documents are affected by the following
problems, try adjusting the printhead. ¢ Attaching the Roll Holder to Rolls P.320 -... Checking the Layout in a Preview Before Printing Checking the Layout in a Preview Before Printing This topic describes how to check the layout before printing using the Canon imagePROGRAF Preview function. Important Matching Mode Description Remarks
Driver Matching Mode Enables printing of optimal color tones You should normally select this mode. Page size: A4 (210.0x297.0 mm)/Letter (8.3 x 11.7 in) * Paper: Roll ¢ Paper type: Canon Glossy Photo Paper 170gsm Roll paper width: 10 inches (254.0 mm) * In the application, create an original that takes up the entire space of the paper size. Note
The message on the right is displayed. Cutting Roll Paper After Printing (Mac OS) iPF770 Click the Page Setup tab to display the Page Setup sheet. Printer Menu Operations iPF770 Printer Menu Printer Menu Printer Menu Operations ............cccc.cceun.... 406 Menu Operations ..........ccceeevvvennnnnn. 407 Menu Structure .........c.ccceeevvveneennnnns iPF770 The paper is
too small. Page 264 Page Setup Pane iPF770  Enlarged/Reduced Printing Select this checkbox to choose the following options. « Hold down A or V¥ to increase or decrease the value continuously. Printing Multiple Pages Per Sheet (Mac OS) iPF770 Select and click a roll paper in the Paper Source list. Color Settings Panel iPF770 * The number of
settings available for selection depends on the media type. The Select Printer dialog box is displayed. iPF770 Page Options Dialog Box ¢ No Spaces at Top or Bottom (Conserve Paper) Activate this setting to print the next image skipping blank areas above and below printable data in documents, which enables you to conserve the paper. ¢ If you want
to change the display to another file or application while the Printing Wizard is open, close the Printing Wizard dialog box. For details on available printing conditions, see "Printer Driver Settings ." P.140 - Note Confirming Print Settings Confirming Print Settings There are two ways to confirm the print settings, as follows. Make sure that Connect to
the Internet to get the latest information is selected, and then click the OK but- ton. Monochrome Disables color printing and converts image from continuous color to grayscaled mono- chrome. Select the Enlarged/Reduced Printing check box. 464 Job Management Using imagePROGRAF Printmonitor .................. 465 Accounting (Windows) Accounting
Manager .......ccoeevvvneeeiineennnnns iPF770 Print on the Center Print on the Center Print on the Center You can print on the center of the media loaded in the printer. The displayed items are indicated by annotations. Page 589 Spolupracou na spravnej likvidacii tohto produktu prispejete k i¢innému vyuzivaniu prirodnych zdrojov. iPF770 Printing with
Selecting the Layout Printing with Selecting the Layout Printing with Selecting the Layout You can print which conserves paper by selecting the layout. Page 403 iPF770 Control Panel Display Display Transitions in Error Status The display transitions while an error has occurred on the printer are shown below. Double-click Untitled in the list at left,
and then enter a name for the page size you want to register. * This function cannot be used with a 64-bit version OS. Page 468 Accounting Manager Main Window iPF770 ¢ Listed Job Selection Area You can use this area to select which job log is displayed. Page 361 If the following message is displayed, configure the settings by using the following
procedure. (See "Loading Rolls in the Printer.") P.322 ... * For more information on the procedure for opening the Media Configuration Tool main window, see "Media Configuration Tool Main Window." P.379 - Note The Edit Media Types dialog box is displayed. On the Tab Selection screen of the Control Panel, press « or p to select the
Settings/Adj. Pause Print Choose On to stop printing. Page 35 iPF770 Printing Office Documents (Mac OS) ¢ Page Setup might not be displayed in the menu de- pending on the OS you are using and the applica- Note tion software. ¢... Download the media information file (.amx file) corresponding to the printer to update from the Canon web- site. 340
Output Stacker ................... Instructions are displayed on the Display Screen. Ink Tank Cover (Inside) Ink Tank Cover (Inside) Left Side Right Side Ink Tank Lock Lever A lever that locks the Ink Tank in place and protects it. The roll is empty. Page 254 Main Pane iPF770 Configuration using Easy Settings ¢ Print Target Choose presets that match the



type of document to be printed. Press the Power button to turn on the printer. IPP Printing IPP Printer URI RAW Printing Raw Mode Bi-direction Network Interface Physical Interface Network interface settings values. Page 231 iPF770 Borderless Printing(PowerPoint) Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon. Cause Corrective
Action There is no ink left in an ink tank. Borderless Printing at Actual Size (Mac OS) iPF770 Click the Page Setup tab to display the Page Setup sheet. 38 Adjusting Images ................. iPF770 Printing Office Documents Select the paper width of the roll loaded in the printer for Roll Width. In the Control Panel, set Auto Rotate to Off and print again. *
You can check the settings values selected in the Print Target list by clicking View Settings. * For tips on confirming print settings, see "Confirming Print Settings ." P.143 - Note Printing Originals Centered on Rolls (Mac OS) Printing Originals Centered on Rolls (Mac OS) This topic describes how to center originals before printing on rolls based on
the following example. Printhead Fixer Cover Holds the Printhead in place. iPF770 Configuring the Destination in TCP/IP Networks Mac OS Settings Mac OS Settings Configuring the Destination in TCP/IP Networks .................... Some of the printer driver settings may be disabled. « NetBIOS is not supported. iPF770 User's Guide Basic Printing
Workflow Enhanced Printing Options Windows Software Mac OS Software Handling and Use of Paper Control Panel Printer Parts Network Setting Print Job Management Adjustments for Better Print Quality Adjusting the Printhead .............. 480 Adjusting the feed amount .............. 487 Maintenance and Consumables Troubleshooting Error Message...
Using the Fol- ded Duplex function allows you to print with fold lines added. Changing Media Names iPF770 In the Edit Media Types dialog box, click the Update button. Select the Page Layout check box. USB Port Connect a USB cable to this port. Page 123 iPF770 Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS) This example
illustrates how to rotate an A4 (210.0x297.0 mm)/Letter (8.3 x 11.7 in) original in portrait orientation 90 degrees to fit within the width of A3/A4 roll (297.0 mm [11.7 in]), which enables you to conserve paper. Clean the Printhead. If the paper still rubs against the print- ter absorbing ink. Page 339 iPF770 Reducing Dust from Cutting Rolls Press A or
V to select On, and then press the OK button. iPF770 Keeping Track of the Amount of Roll Paper Left Keeping Track of the Amount of Roll Paper Left Keeping Track of the Amount of Roll Paper Left Setting ManageRemainRoll to On in the Paper Menu of the Control Panel will print a barcode with text on the roll when the roll is removed that identifies
the type of paper and amount left. dialog box, you can check details of the selected printing application. Page 1 Large Format Printer User's Guide Basic Printing Workflow Enhanced Printing Options Printing CAD Drawings............. 38 Printing enlargements or reductions......... 58 Printing at full size.............. 68 Borderless Printing.............. 77 Printing
banners or at other non-standard sizes....... 86 Tiling and multiple pages per sheet.......... Printing with Watermarks—COPY, FILE COPY, and so on (Windows) iPF770 * Printing with Watermarks—COPY, FILE COPY, and so on (Windows) P.130 - Printing with Watermarks—COPY, FILE COPY, and so on (Windows) Printing with Watermarks—COPY, FILE
COPY, and so on (Windows) This topic describes how to print with watermarks, based on the following example of printing with a FILE COPY watermark. Yellow Adjusts the strength of colors to compensate the hues. Click the Center Originals Across Roll check box on. Press the power button to turn the printer on. iPF770 Fine-Tuning the Paper Feed
Amount Press A or V¥ to select the pattern number you have decided, and then press the OK button. The printer will now start up. Page 378 Updating Media Information After Installation iPF770 Run the Media Configuration Tool, then select Speci- fy the Media Information File and click the Browse button in the Add Media Type dialog box. Push the
Printhead Fixer Lever toward the back of the printer until it clicks. Important Printer Power supply 100-240 V AC (50/60 Hz) Power consumption During operation 140 W max. iPF770 Media Configuration Tool Main Window The Confirm Update dialog box is displayed. 453 Configuring the Destination for Bonjour Network ................... When this
setting is off, printing is per- formed without changing the position. (xxxxxx) Click OK to display the Network page. To update the media information, click the OK button. Easy Settings Easy Settings You can easily select the best settings for the print job by just selecting an item from the print target list that match-... Page 8 Control Panel Operations
and Display Screen Control Panel ..........cccccoveveiinennnnnns The larger value is used if the margin specified in the printer driver does not match the margin in the printer menu. ¢ Edit Button From the Hot Folder list, select a hot folder and click the button to open the Add/Edit Hot Folder dialog box that allows you to edit the hot folder. Resizing by
specifying a scaling value Select an object. Choose a fitting icon for these print settings in the Icon list. 169 Preview Main Window ...........cc.ccceevvnennnn. Page 37 iPF770 Using PosterArtist to Compose Originals Click the Layout tab to display the Layout sheet. Check ink tank............ 564 Cannot detect ink level correctly. Portrait Orientation/Landscape
Orientation(PowerPoint) iPF770 Click the Nextbutton. For details on Print Matching Roll Width, see "Print Matching Roll Width(Word)."... Click Poster (2 x 2) in the Page Layout list. (See "Turning the Printer On and Off.") P.15 - Load the roll on the Roll Holder. The Features of imagePROGRAF Status Monitor iPF770 Status Monitor (Windows) Status
Monitor (Windows) The Features of imagePROGRAF Status Monitor .................... Page 350 Using the Output Stacker iPF770 Hold onto the Output stacker handle (a) and pull the Output stacker release lever (b) towards you. iPF770 The Features of Free Layout Free Layout Free Layout The Features of Free Layout ...........c.c.cccuunnenne. In other cases, the
Cutter Contact your Canon dealer for assistance. iPF770 Resizing Originals by Entering a Scaling Value Make your selection in the Print Quality list. Page 116 Printing Originals Centered on Rolls (Mac OS) iPF770 Access the Main pane. ¢ If no print job was received A menu for selection of the type of paper is automatically shown on the Display
Screen. 488 Manual Banding Adjustment ........................ 489 Fine-Tuning the Paper Feed Amount ...................... 491 Adjusting Line Length .........ccccccvvuneiennni. (See "Control Panel Display.") P.400 -... Wipe away any ink residue on the Platen as a whole (a), the Paper Retainer (b), Borderless Printing Ink Grooves (c), and Ejection Guide (d). Switch the
printer off immediately and remove the power plug from the power outlet. Page 585 Votre entiere coopération dans le cadre de la mise au rebut correcte de ce produit favorisera une meilleure utilisa- tion des ressources naturelles. Select Print Range from All Pages, Current Page, or Pages. However, if you have specified the leading margin in Pa- per
Details, the larger of the setting values has priority. iPF770 Job Management Using imagePROGRAF Status Monitor Job Management Using imagePROGRAF Status Monitor Job Management Using imagePROGRAF Status Monitor You can use the Job sheet in imagePROGRAF Status Monitor for operations such as pausing and canceling print jobs.
iPF770 Printing Multiple Pages Per Sheet (Windows) For instructions on printing multiple pages per sheet, refer to the following topics, as appropriate for your com- puter and operating system. iPF770 Configuring Special Settings Click the Binding Settings button. Note Adjusting Monochrome Use the monochrome setting to print monochrome
images of color photographs captured with a scanner or digital camera or other color images. Place the pointer at a corner of the selection box around the object to show the arrow handle, and drag this handle to change the object size. Setting the Unit Cost for Paper iPF770 Setting the Unit Cost for Paper Setting the Unit Cost for Paper Opens the
Paper sheet. Doing so may result in unexpected accidents and can cause a fire or elec- trical shocks. (See "Displaying the Paper Reference Guide.") P.313 - Push the Release Lever back and remove the paper. Select and click a roll paper in the Paper Source list. Clearing a Jammed Sheet Clearing a Jammed Sheet If a sheet becomes jammed, "Paper
jam." is shown on the Display Screen of the Control Panel. iPF770 Configuring the Printer Driver Destination (Windows) Press A or ¥ to select IPv6 Support, and then press the OK button. If the job to cancel is not shown in the printer window (that is, if the print data has already been received by the printer), double-click the taskbar icon to display
imagePROGRAF Status Monitor. Printing from AutoCAD iPF770 Access the Page Setup pane. *5: Not displayed if Auto Detect is On. *6: Follows the setting in Date Format. Borderless printng not possible. Cutter Rail The Cutter Unit passes over this rail to cut paper. * Once you set IPv6 Support to On, the IPv6 StlessAddrs setting takes effect. Select
the Banner Printing check box. * Matching Mode Select the color matching mode to use, as desired. Specify the printer profile as desired. Page 55 iPF770 Choosing the Document Type and Printing Conditions (Windows) Click Advanced Settings to switch the print mode. Ink tank is empty. Important A message will appear informing you that analysis
is in progress. Priority is Automatic or Print Quality. ¢« Status Bar This shows the paper source, roll paper width, and output size. Resizing Originals to Match the Paper Size iPF770 Printing enlargements or reductions Printing enlargements or reductions Resizing Originals to Match the Paper Size ....................... HP-GL/2 Printing HP-GL/2 Printing
This printer supports printing using the original Canon GARO printer control language and printing using HP-GL/2 and HP RTL emulation to print in colors resembling the colors produced by printers from other companies. Use Ethernet Use Ethernet settings values. After you have read Canon Software License Agree- ment, click the Continue button.
Once the printing has finished, use the following procedure to return to the regular position. The Large-Format Printing Wizard dialog box is displayed. ¢ Update Printer Info. Page 149 iPF770 Main Sheet Common Items * Media Type Select the type of paper. Make your selection in the Print Quality list. (See "Main Sheet .") P.148 - Note ¢ Paper
Source Shows the paper source supported by the printer, as well as information about the loaded paper. Page 533 iPF770 Clearing Jammed Paper (Paper Feed Slot) Positioning your hands as shown, open the Roll Cover. 216 Print Matching Roll Width(Word) ........................ The level is loW ......oeevvnneennnnnnnen. 569 No Maintenance Cartridge
Capacity....cccoeevverevnnnnnns Drag each slider to the left or right to adjust. (This is identified as Printers &... Pour plus d'informations sur le recyclage de ce produit, contactez vos services municipaux, votre éco-organisme ou les autorités locales compétentes, ou consultez le site www.canon-europe.com/weee , ou » www.canon-europe.com/battery -...
Types of tabs The Tab Selection screen presents four tabs. * Do not remove the Maintenance Cartridge during initialization immediately after replacing the Mainte- nance Cartridge. 58 Printing at full size ................ 68 Borderless Printing ................ Quali- Auto(GenuinePpr) | Auto(OtherPaper) | Manual ty( *2 ) Adjust Adjust- A:High | B:Standard/Draft
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